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INTRODUCTION

Thank you for choosing this Mitsubishi Inverter Setup Software.
This instruction manual gives handling information and precautions for the use of this software. Incorrect handling might 
cause an unexpected fault. Before using the software, please read this manual carefully to use the software to its optimum 
performance.
Please forward this manual to the end user.

When reading this manual, note the following.

 • This manual is written on the basis that Windows® 7 Professional (English version) is the operating system.
 • Drive D is described as the DVD drive and Drive C as the hard disk drive.

Trademarks
 • Microsoft Windows and Excel are registered trademarks or trademarks of Microsoft Corporation in the United States and/or 

other countries.

(1)  The formal name of Windows® XP is Microsoft® Windows® XP operating system.

(2)  The formal name of Windows Vista® is Microsoft® Windows Vista® operating system.

(3)  The formal name of Windows® 7 is Microsoft® Windows® 7 operating system.

(4)  The formal name of Windows® 8 is Microsoft® Windows® 8 operating system.
 • "FR Configurator2" is a registered trademark of Mitsubishi Electric Corporation.

The copyright and other rights of this software all belong to Mitsubishi Electric Corporation.
 • No part of this manual may be copied or reproduced without the permission of Mitsubishi Electric Corporation.
 • Other company and product names herein are the trademarks and registered trademarks of their respective owners.
 • SPREAD

Copyright (C) 2003-2004, FarPoint Technologies, Inc. All rights reserved.
 • TeeChart

Copyright (C) 1997-2005 by David Berneda, Steema Software
 • XtremeToolkit

Copyright (C) 1998-2009 Codejock Software, a division of Codejock Technologies, LLC
 • CodeProject

 "A slider with 2 buttons" by includeh10, an Australia member of www.codeproject.com, licensed under CPOL

For Maximum Safety

 This product has not been designed or manufactured for the use with any equipment or system 
operated under lifethreatening conditions.

 Please contact our sales office when you are considering using this product in special applications 
such as passenger mobile, medical, aerospace, nuclear, power or undersea relay equipment or 
system.

 Although this product was manufactured under conditions of strict quality control, you are strongly 
advised to install safety devices to prevent serious accidents when it is used in facilities where 
breakdowns of the product are likely to cause a serious accident.
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1 OUTLINE

This chapter explains the "OUTLINE" for use of this product.
Always read the instructions before using the software.

1.1 Before using this software............................................................................. 6
1.2 System configuration ..................................................................................... 8
1.3 Installation and uninstallation ....................................................................... 10
1.4 Connection and parameter setting................................................................ 14
1.5 Setting of operation mode of the inverter .................................................... 28
1.6 Start and close of FR Configurator2 ............................................................. 31

<Abbreviations>
 • PU: Operation panel (FR-DU08) and parameter unit (FR-PU07)
 • Inverter: Mitsubishi inverter FR-A800 series
 • FR-A800: Mitsubishi inverter FR-A800 series
 • Pr.: Parameter number (Number assigned to function)
 • PU operation: Operation and frequency commands are given by the operation panel (FR-DU08), parameter unit (FR-

PU07), or RS-485 communication, via the PU connector.
 • External operation: Operation and frequency commands are given by an external potentiometer and switches, via control 

circuit terminals.
 • Combined operation: Combined operation using the PU (FR-DU08/FR-PU07) and External operation
 • Mitsubishi standard motor: SF-JR
 • Mitsubishi constant-torque motor: SF-HRCA
 • Vector control dedicated motor: SF-V5RU

<Mark>
[       ]          :Indicates a menu selected from menu bar, or button used on windows.
"       "          :Indicates a title name of a window.



Before using this software
1.1 Before using this software
 • This software is an effective support tool for startup and maintenance of the Mitsubishi general-purpose inverter. The 

following functions can be performed efficiently on a personal computer.

NOTE
 • If a file name or folder name is using Unicode, file writing or reading may not be performed correctly. Please use a file name 

and folder name without Unicode.
 • The following functions are not compatible with this software.

 Application starting with Windows®compatibility mode
 Starting using "Run As..."
 Fast User Switching
 Remote Desktop
 Large font size (Advanced setting of screen property)
 DPI setting other than the normal size (Advanced setting of screen property)
 Windows XP Mode
 Windows Touch

 • A part of this software is using a function of Internet Explorer. This software may not operate properly depending on Internet 
Explorer setting.

 • FR Configurator2 is not available when inverter is activated with FR-PU07BB Battery mode. FR Configurator2 may not 
operate properly.

Related manuals

The manuals related to this product are shown below.
The download of the latest manuals is free at the Mitsubishi Electric FA Global Website.

Function Description Trial 
version

Parameter List Displays parameter list, functional list, and initial value change list and allows editing of the parameters. 

Diagnosis Displays faults history. 

Graph Displays the values monitored by the high speed or monitor sampling and the USB trace file in a graph 
format. 

Batch Monitor Displays the monitored items of the inverter in a batch. 

Test operation
"Test operation" allows the selected inverter's frequency to be displayed, operation mode to be switched 
and displayed, forward and reverse operation commands to be sent, setting frequency to be written, and 
other functions to be done.



Developer Used for creating sequence programs and writing them to the inverter to enable the use of the PLC 
function of the inverter. 

USB memory 
parameter copy 
file edit

Used for editing the parameter setting values (USB memory parameter copy file) read from the inverter to 
the USB memory. 

Help Displays contents of the inverter and software instruction manuals. 

(: Available,  : Unavailable)

Manual name Manual 
number

FR-A800 Instruction Manual (Startup) IB-0600493

FR-A800 Instruction Manual (Detailed) IB-0600503ENG

FR-A802 (Separated Converter Type) Instruction Manual (Hardware) IB-0600534ENG

FR-A800 PLC Function Programing Manual IB-0600492ENG

GX Works2 Version 1 Operating Manual (Common) SH-080779ENG
6 OUTLINE



Before using this software

1

 • Check the following settings before configuring the inverter with this software. For the details of communication 
parameters, refer to page 14.

 To use the Developer, parameter setting of the inverter is required. (Refer to page 20)

1.1.1 Product confirmation
After unpacking, check that the following items are contained in the package:

Item Quantity
DVD 1

Installation Manual 1

USB connection

Set Pr. 548 USB communication check time
interval = "9999".

Set the operation
mode to PU operation
mode.

Connecting with
which method?

Connection using PU connector

Operation steps

Check the system
configuration

Install
FR Configurator2

The parameter settings 
can be used with the 
initial values.

Set the station number (when connecting
multiple inverters) in Pr. 331 RS-485
communication station number.
Set Pr. 336 RS-485 communication check time
interval ≠ "0" and,
Pr. 337 RS-485 communication waiting time setting 
= "9999".

Start FR Configurator2

Connection using RS-485 terminal

Set the operation
mode to NET operation
mode.

(Refer to page 22)

(Refer to page 19)

(Refer to page 16)

(Refer to page 8)

(Refer to page 10)

(Refer to page 31)


OUTLINE 7



System configuration
1.2 System configuration

1.2.1 System requirement for FR Configurator2

 Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
Pentium is a registered trademark of Intel Corporation.

 FR Configurator2 may not function properly depending on the using personal computer, peripheral devices, and software.
 Operation on an operating system not listed here is not guaranteed.

1.2.2 Compatible inverters
FR Configurator2 is compatible with the following inverters.

Components  Description 

Personal 
computer

IBM PC/AT compatible machine with DVD drive (for installation), USB port or serial port

OS 

• Windows® 7, Windows® 8, Windows® 8.1/Pro/Enterprise (32-bit Edition and 64-bit Edition)
• Windows Vista® (32-bit Edition)
• Windows® XP Professional SP3 or later (32-bit Edition)
• Windows® XP Home Edition SP3 or later

Processor • Desktop PC: Intel® Celeron® Processor 2.8 GHz or higher
• Laptop PC: Intel® Pentium® M Processor 1.7 GHz or higher

Memory

• 1 GB or more (Windows® 7, Windows® 8, Windows® 8.1 32-bit Edition)
• 2 GB or more (Windows® 7, Windows® 8, Windows® 8.1 64-bit Edition)
• 512 MB or more (Windows Vista®)
• 128 MB or more (Windows® XP Professional, Windows® XP Home Edition)

Hard disk Free area of 1.5 GB or more

Software Internet Explorer 5.0 or later

Display Applicable to display at resolution of 1024  768 or more, and 256 colors or more. Compatible with the above personal 
computer.

Keyboard Compatible with the above personal computer.

Mouse Compatible with the above personal computer.

Printer Compatible with the above personal computer.

Series Model Capacity Structure, functionality

FR-A800 series

FR-A820 00046(0.4K) to 04750(90K)
Standard model

FR-A840 00023(0.4K) to 06830(280K)

FR-A842 07700(315K) to 12120(500K) Separated converter type
8 OUTLINE



System configuration

1

1.2.3 System configuration
The following devices are required to use FR Configurator2. Set up the system in accordance with the instruction manual of each device.

 When using serial port of a personal computer, a commercially available converter is required.
Examples of product available on the market (as of February 2012)
Model: DINV-CABV (with connectors and cable)
Diatrend Corp.
The converter cable cannot connect two or more inverters (the computer and inverter are connected on a 1:1 basis). This is a RS- 232C/RS-485 
conversion cable with built-in converter. No additional cable or connector is required. Contact a manufacturer for details of the product.

 Connection cable
Examples of product available on the market (as of February 2012)
Connector: RJ45 connector
Example: Tyco Electronics
5-554720-3
Cable: Cable in compliance with EIA568 (such as 10BASE-T cable)
Example: Mitsubishi Cable Industries, Ltd.
SGLPEV-T (Cat5e/300 m) 24 AWG  4 P

 USB/RS-485 convert cable
Examples of product available on the market (as of February 2012)
Model: DINV-U4
Diatrend Corp.
Refer to page 36 for the communication setting with DINV-U4. When using USB/RS-485 convert cable, use the newest driver software. For a 
product details or the newest driver software, contact the cable manufacturer.

 Recommended USB cable for computer-inverter connection
MR-J3USBCBL3M Cable Length 3 m

 Communication with PU connector, RS-485 terminal, or USB connector is available.
 Maximum overall length of connection cable: 500 m
 The USB or a serial port (one of ports 1 to 63) can be used as the communication port. Set the communication port in the Communication settings 

screen of FR Configurator2. (Multiple ports cannot be used at the same time.) One personal computer is connected to one GOT. When using the 
USB for connecting a GOT, use a dedicated cable, GT09-C30USB-5P or GT09-C20USB-5P. Only the USB connection is available for connecting the 
GOT2000 series to a personal computer. For the GOT1000 series, an RS-422 communication unit (GT15-RS4-9S) is required.

 For the compatible version of GOT or details of the RS-422/485 connection, refer to the GOT1000/GOT2000 Series Connection Manual.

Name Model Manufacturer

Communication cable SGLPEV-T (Cat5e/300 m) 
24AWG  4P Mitsubishi Cable Industries, Ltd.

RJ-45 connector 5-554720-3 Tyco Electronics

Inverter

∗1Converter 
RS-485 cable

∗5

Serial 
port

USB
connector

USB
connector

Using USB connector

PU
connector

FR Configurator2
Commercially available

printer

Connection cable
RS-485/RS-422

Multidrop link system

Inverter

Inverter

Inverter Inverter Inverter

RS-485
terminal

∗6

∗2

Converter 

∗4

RS-485
terminal

RS-485
terminal

RS-485
terminal

RS-485
terminal

 GOT1000/GOT2000

 

USB connector or 
Serial port ∗7

∗8
RS-422 

communication unit
OUTLINE 9



Installation and uninstallation
1.3 Installation and uninstallation

1.3.1 Installation of FR Configurator2
To use FR Configurator2 (SW1DND-FRC2-E), the files included on the setup disk (DVD) or the downloaded file must be 
installed onto the personal computer.
Check the following points before the installation.

 • Close any other applications that have already been running.
 • For the installation, log on as an administrator (Administrator account) and start installation.
 • If an inverter is connected by the USB cable, disconnect the USB cable.
 • Installation files are compressed. Copying the files does not start FR Configurator2 yet. Install the software using the setup 

program.
 • To install the software, follow the installation procedure in Windows screen.
 • In an operation system with antivirus/security software, a warning may appear when installing FR Configurator2. If a 

warning appears, permit the installation of FR Configurator2 according to the setting procedure of your antivirus/security 
software.

Installation procedure
The following section describes the procedures of installing FR Configurator2.

NOTE
 • Installation can be started by double-clicking the icon of DVD drive or the following procedure.

1)Choose the [Run...] command from [Start] menu.
2)"Run" window appears.
3)Type "D:\SETUP" (with one-byte characters) in "Open" field and click [OK]. (When DVD drive is D drive)

 • When using Windows Vista or Windows 7, the following window may appear during the installation. Click "Continue".

(1) Insert the DVD to an available DVD drive. Installation starts automatically.

Click "Yes"
10 OUTLINE



Installation and uninstallation

1

NOTE

 • The following window may appear during the installation.

 • Continue the installation by clicking [Continue Anyway] for Windows XP and "Install" for Windows Vista, Windows 7 or 
Windows 8.

(2) The window shown on the right is displayed.
Click [Next>].

(3) Enter user name and company name.
Click [Next>] after entering.

(4) Check the installation folder and click [Next>].
To change the installation folder, click
[Change...] and select an installation folder. 
A new folder "FRC2" is created at the selected
installation folder. This software is installed there.
(If the installation folder is not changed, the 
software is installed at 
"C:\Program Files\MELSOFT\FRC2")

(5) Check that the setting is correct and click
[Install].
Installation will start.
To change the setting, click [<Back].

For Windows XPFor Windows Vista or Windows 7

Click and continue
OUTLINE 11



Installation and uninstallation
NOTE
 • When Windows Vista or Windows 7 is used, the "Program Compatibility Assistant" dialog box may appear when completing 

the installation. If the window appears, select "This program installed correctly".
 • If the user is not an administrator (Administrator account), the installation cannot be performed. Log in as a user with 

administrator authority, and start the installation again.

(6) Installation is completed.
Click [Finish] to close the window. Restart the
personal computer before using the software.
12 OUTLINE



Installation and uninstallation

1

1.3.2 Uninstallation of FR Configurator2
Open the [Start] menu of Windows, and then click [Control Panel]. Click "Programs" in the "Control Panel" window.
When "Programs and Features" window is displayed, select "FR Configurator2" to start uninstallation.

When the uninstallation starts, the following confirmation dialog appears.

Click [Yes] to proceed the uninstallation. (Click [No] to cancel the uninstallation.)
The following window is displayed when the uninstallation is completed. Click [Finish] to close the window.

NOTE
 • Uninstallation is unavailable while the application is running. Perform the uninstallation after closing the application.
 • For Windows XP, uninstall the software as follows.

1. Select [Control panel] on the start menu and display the [Add or Remove Programs] window.
2. Select FR Configurator2 and click the [Delete] button.
OUTLINE 13



Connection and parameter setting
1.4 Connection and parameter setting

1.4.1 Connection method
For FR Configurator2, communication via USB connector, PU connector, RS-485 terminal block, or GOT is available. USB 
connection is initially selected. The Developer function is available only during communication via the PU connector.

 • USB connection (Refer to page 16)
Connect to USB connector (mini B connector) of the inverter. 
1:1 connection is supported. Connection with using USB hub is 
not supported.

 • Serial communication (PU connector) 
(Refer to page 19)
Connect to PU connector of the inverter. Serial port/RS-485 
converter (cable) or USB/RS-485 converter (cable) is required.

 • Serial communication (RS-485 terminal) (Refer to page 22)
Connect to RS-485 terminal of the inverter. Up to 32 inverters can be connected.

USB cablePersonal computer
(FR Configurator2)

Inverter

USB mini B 
connector

USB connector

converter

Serial cable
Personal computer
(FR Configurator2)

Inverter

PU connector

RS-232C     RS-485

Serial port or USB connector

converter

USB cable

Inverter

PU connector

USB     RS-485

 

- -  RS-232C     RS-485
converter 

Serial cable

RS-422 / 485 Up to
32 inverters 

 Personal computer
(FR Configurator2)  

Inverter 

RS-485 terminal block 

Serial port
14 OUTLINE



Connection and parameter setting

1

NOTE
 • Inserting or pulling out a USB cable during FR Configurator2 operation may cause the inverter to be unrecognized. Insert and 

pull out the USB cable for several times, or reset the inverter with the USB cable connected to the personal computer.
 • If the Pr. 999 Automatic parameter setting setting is changed to "10 or 11" using the operation panel, parameter unit, etc. 

during FR Configurator2 operation, the inverter communication parameters will be changed, and such setting may disable the 
communication with FR Configurator2.
Do not set Pr. 999 while FR Configurator2 is used. (For Pr. 999, refer to the Instruction Manual (Detailed) of the inverter.)

 • Only the USB connection is available for connecting the GOT2000 series to a personal computer.

 • Communication through GOT (USB / Serial communication) 
(Refer to page 22)
Through a GOT (Human Machine Interface), connection to the 
RS-485 terminal block is available. For the GOT1000 series, 
an RS-422 communication unit is required. For the compatible 
version of GOT or details of the RS-422/485 connection, refer 
to the GOT1000/GOT2000 Series Connection Manual.

GOT2000

RS-422/485

Up to 32 inverters can be connected.

Personal computer
(FR Configurator2)

USB cable

RS-485 terminal block

USB connector
OUTLINE 15



Connection and parameter setting
1.4.2 Connection using USB connector

 • Applicable cable

A personal computer and inverter can be easily connected with 
USB cable. 1:1 connection is supported. Connection using USB 
hub is not supported.

To communicate with FR Configurator2 by the USB connection between the inverter and a personal computer, use the USB 
mini B connector at the inverter side

Interface Conforms to USB1.1

Transmission speed 12 Mbps

Wiring length Maximum 5 m

Connector USB mini B-connector (receptacle mini B type)

Recommended USB cable MR-J3USBCBL3M (cable length: 3 m)

USB cablePersonal computer
(FR Configurator2)

Inverter

USB mini B 
connector

USB connector

USB host 
(A connector)

USB device 
(mini B connector)

Communication 
status LED
16 OUTLINE



Connection and parameter setting

1

Related parameters for USB connection
Set the following communication parameter when connecting the USB connector of the inverter. When performing 
parameter writing or run command input, set the following command source parameters, and switch the operation mode to 
PU operation mode.

NOTE
 •  Switching of the operation mode is available using "test operation" (on page 75) or "parameter list" (on page 49) on the sub 

window.
 • Set a station number of the each inverter in Pr.547 USB communication station number. Perform inverter reset after 

setting the parameter.

 • Related parameter list

 Changed settings are enabled at the next power-ON or inverter reset.
 Pr. 551 is always write-enabled.

NOTE
 • Always reset the inverter after making the setting of the parameters. After you have changed the communication-related 

parameters, communication cannot be established until the inverter reset.

Inverter
Parameter setting Operation

modeCommunication parameter Command source parameter

FR-A800 Pr.548 USB communication check time interval = 
"9999 (initial value)"

Pr.551 PU mode operation command source 
selection = "3 or 9999"
(initial value 9999)

PU

Pr. Name Initial value Setting
range Description

547

N040
USB communication station 
number 0 0 to 31 Inverter station number specification.

548

N040
USB communication check time 
interval 9999

0 USB communication is possible.
Trips in the PU operation mode (E.USB)

0.1 to 999.8 s

Sets the interval of communication check time.
If a no-communication state persists for longer 
than the permissible time, the inverter trips 
(E.USB).

9999 No communication check

551

D013
PU mode operation command 
source selection 9999

1 Selects the RS-485 terminal as the PU 
operation mode command source.

2 Selects the PU connector as the PU operation 
mode command source.

3 Selects the USB connector as the PU operation 
mode command source.

9999

USB automatic recognition
Normally, operation panel (PU connector) is the 
command source. During USB connection, 
USB is the command source.
OUTLINE 17



Connection and parameter setting
When connecting USB for the first time

If a personal computer and inverter are connected via USB for the first time with the inverter power ON, "Found New 
Hardware Wizard" window is displayed.
The following additional wizard is displayed for Windows XP. For Windows Vista and Windows 7, inverter is automatically 
detected.

(1) Select "No, not this time", and click [Next].

(2) Select "Install the software automatically 
(Recommended)" and click [Next].

(3) If the dialog box shown on the right is displayed when
using Windows XP, click [Continue Anyway] to
proceed the installation.

(4) The installation of the driver is completed.
Click [Finish] to close the window.
18 OUTLINE



Connection and parameter setting

1

1.4.3 Connection using PU connector

PU connector pin layout

NOTE
 • Refer to the following when fabricating the cable on the user side.

Commercially available product example (as of February 2012)

 • Distributor is necessary when connecting multiple inverters.
Refer to the inverter manual for connecting multiple inverters.

 • Pins No. 2 and 8 provide power to the operation panel or parameter unit. Do not use these pins for RS-485 communication. 
(Refer to the inverter Instruction Manual for details.)

 • Do not connect the PU connector to the computer's LAN board, FAX modem socket or telephone modular connector. 
The product could be damaged due to differences in electrical specifications.

PU connector is used for connecting with a computer. Serial 
port/RS-485 converter (cable) or USB/RS-485 converter 
(cable) is required. 1:1 connection is supported.

Pin
number Name Description

1 SG Earth (Ground)
(Connected to terminal 5)

2 — Operation panel power supply

3 RDA Inverter receive+

4 SDB Inverter send-

5 SDA Inverter send+

6 RDB Inverter receive-

7 SG Earth (Ground)
(Connected to terminal 5)

8 — Operation panel power supply

converter

Serial cable
Personal computer
(FR Configurator2)

Inverter

PU connector

RS-232C     RS-485

Serial port or USB connector

converter

USB cable

Inverter

PU connector

USB     RS-485

8 1

Inverter
(receptacle)
Front view

Example with FR-A800

Product name Type Manufacturer
10BASE-T cable SGLPEV-T 0.5 mm  4P Mitsubishi Cable Industries, Ltd.

RJ-45 connector 5-554720-3 Tyco Electronics

 Do not use pins No. 2, 8 of the 10BASE-T cable.
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Connection and parameter setting
Related parameters for connection using PU connector
Set the following communication parameter when connecting PU connector of the inverter.
When performing parameter writing or run command input, set the following command source parameters, and switch the 
operation mode to the following operation mode.

NOTE
 • Set 3 s or more (or 9999) in Pr.122 PU communication check time interval.
 • Set a station number of the each inverter in Pr.117 PU communication station number when connecting multiple inverters. 

Perform inverter reset after setting the parameter.
 • Related parameter list

Inverter Communication
option

Parameter setting Operation
modeCommunication parameter Command source parameter

FR-A800 —

Pr.122 PU communication check time 
interval  "0"
Pr.123 PU communication waiting time 
setting = "9999 (initial value)"

Pr.551 PU mode operation command 
source selection = "2 or 9999"
(initial value 9999)

PU

Pr. Name Initial value Setting
range Description

117
N020

PU communication station 
number 0 0 to 31 

Inverter station number specification.
Set the inverter station numbers when two or more 
inverters are connected to one personal computer.

118
N021 PU communication speed 192

48, 96, 192,
384, 576,
768, 1152

Set the communication speed.
The setting value  100 equals the communication speed.
For example, if 192 is set, the communication speed is 
19200 bps.

E022 PU communication data length 0
0 Data length 8 bits

1 Data length 7 bits

E023 PU communication stop bit 
length 1

0 Stop bit length 1 bit

1 Stop bit length 2 bits

119 PU communication stop bit 
length / data length 1

0 Stop bit length 1 bit
Data length 8 bits

1 Stop bit length 2 bits

10 Stop bit length 1 bit
Data length 7 bits

11 Stop bit length 2 bits

120
N024

PU communication parity 
check 2

0 Without parity check

1 With parity check at odd numbers

2 With parity check at even numbers

121
N025

Number of PU communication 
retries 1

0  to 10
Set the permissible number of retries for unsuccessful data 
reception. If the number of consecutive errors exceeds the 
permissible value, the inverter will trip.

9999 If a communication error occurs, the inverter will not trip.

122
N026

PU communication check time 
interval 9999

0

RS-485 communication is enabled. Note that a 
communication fault (E.PUE) occurs as soon as the 
inverter is switched to the operation mode with control 
source.

0.1 to 999.8 s
Communication check (signal loss detection) time interval. 
If a no-communication state persists for longer than the 
permissible time, the inverter trips (depends on Pr. 502).

9999 No communication check (signal loss detection).

123
N027

PU communication waiting time 
setting 9999

0 to 150 ms Set the waiting time between data transmission to the 
inverter and response.

9999 Set with communication data.

549
N000 Protocol selection 0

0 Mitsubishi inverter protocol (computer link)

1 Modbus-RTU protocol
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Connection and parameter setting

1

 Pr.549 = "0" (Mitsubishi inverter (Computer link) protocol).
 Pr.551 is always write-enabled.

NOTE
 • Always reset the inverter after making the setting of the parameters. After you have changed the communication-related 

parameters, communication cannot be established until the inverter reset.
 • To change an inverter parameter value, use the operation panel (FR-DU08) or parameter unit (FR-PU07). Only one of the 

operation unit and FR Configurator2 (personal computer) can be connected to the PU connector.
 • For details on each inverter communication parameter, refer to the Instruction Manual (Detailed) of the inverter.
 • Parameter clear/All parameter clear by the operation panel or the parameter unit clears communication parameter settings 

and disables the communication with FR Configurator2.

551
D013

PU mode operation command 
source selection 9999

1 Selects the RS-485 terminal as the PU operation mode 
command source.

2 Selects the PU connector as the PU operation mode 
command source.

3 Selects the operation panel as the PU operation mode 
command source.

9999

USB automatic recognition
Normally, operation panel (PU connector) is the command 
source. During USB connection, USB is the command 
source.

Pr. Name Initial value Setting
range Description
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Connection and parameter setting
1.4.4 Connection of multiple inverters using RS-485 
terminal

RS-485 terminal is used for connecting multiple inverters with Serial port of a computer.
Up to 32 inverters can be connected. Serial/RS-485 converter (on page 19) is required.

Related parameters for multiple connection using RS-485 terminal
Set the following communication parameter when connecting RS-485 terminal of the inverter.
When performing parameter writing or run command input, set the following command source parameters, and switch the 
operation mode to the following operation mode.

NOTE
 • For the details of wiring, refer to the Instruction Manual (Detailed) of the inverter.
 • Set 3 s or more (or 9999) in Pr.122 PU communication check time interval, Pr.336 RS-485 communication check time 

interval.
 • Set a station number of the each inverter in Pr.117 PU communication station number and Pr.331 RS-485 

communication station number when connecting multiple inverters.

Inverter Communication
option

Parameter setting Operation
modeCommunication parameter Command source parameter

FR-A800

No
Set the station number of the each inverter in 
Pr.331 RS-485 communication station number 
(when connecting multiple inverters)
Pr.336 RS-485 communication check time 
interval  "0"
(initial value 0)
Pr.337 RS-485 communication waiting time 
setting = "9999 (initial value)"

Initial value NET

Yes
Pr.551 PU mode operation 
command source selection = "1"
(initial value 9999) 

PU

 

- -  RS-232C     RS-485
converter 

Serial cable

RS-422 / 485 Up to
32 inverters 

 Personal computer
(FR Configurator2)  

Inverter 

RS-485 terminal block 

Serial port
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Connection and parameter setting

1

 • Related parameter list

 Pr.549 = “0” (Mitsubishi inverter (Computer link) protocol).
 Pr.551 is always write-enabled.

NOTE
 • Always reset the inverter after making the setting of parameters. After you have changed the communication-related 

parameters, communication cannot be established until the inverter reset.

Pr. Name Initial value Setting
range Description

331
N030

RS-485 communication station 
number 0 0 to 31

(0 to 247) 

Set the inverter station number.
Set the inverter station numbers when two or 
more inverters are connected to one personal 
computer.

336
N036

RS-485 communication check time 
interval 0s

0
RS-485 communication is enabled. However, 
the inverter trips if operation is changed to NET 
operation mode.

0.1 to 999.8 s

Set the interval of communication check (signal 
loss detection) time. If a no-communication 
state persists for longer than the permissible 
time, the inverter trips.

9999 No communication check (signal loss detection)

337
N037

RS-485 communication waiting time 
setting 9999

0 to 150 ms Set the waiting time between data transmission 
to the inverter and response.

9999 Set with communication data.

549
N000 Protocol selection 0

0 Mitsubishi inverter protocol (computer link)

1 Modbus-RTU protocol

550
D012

NET mode operation command 
source selection 9999

0 The communication option is the command 
source when in the NET operation mode.

1 The RS-485 terminals are the command source 
when in the NET operation mode.

9999

Communication option is recognized 
automatically.
Normally, the RS-485 terminals are the 
command source. When the communication 
option is mounted, the communication option is 
the command source.

551

D013
PU mode operation command 
source selection 9999

1 Selects the RS-485 terminals as the PU 
operation mode command source.

2 Selects the PU connector as the PU operation 
mode command source.

3 Selects the USB connector as the PU operation 
mode command source.

9999

USB automatic recognition
Normally, operation panel (PU connector) is the 
command source. During USB connection, 
USB is the command source.
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Connection and parameter setting
1.4.5 Connection through GOT (FA transparent 
function)

Using the FA transparent function of GOT1000/GOT2000 series, connecting an inverter to FR Configurator2 is available 
through GOT.
The FA transparent function enables reading, writing and monitoring of a programmable controller of Mitsubishi Electric 
Corporation through GOT, while connecting the Mitsubishi programmable controller and a personal computer.
A serial port or USB is used for connecting the personal computer and GOT. RS422/485 is used for connecting GOT and the 
inverter.

[Example of RS-485 terminal connection]

[Example of PU connector connection]

For the GOT1000 series, an RS-422 communication unit (GT15-RS4-9S) is required. When using the USB for connecting a 
GOT, use a dedicated cable, GT09-C30USB-5P or GT09-C20USB-5P.
For the compatible version of the GOT or details of the RS-422/485 connection, refer to the GOT1000/GOT2000 Series 
Connection Manual.

GOT1000 connection example GOT2000 connection example

GOT1000 connection example GOT2000 connection example

GOT RS-422

GOT1000

communication unit

USB connector/ 
Serial port

USB/serial cable

RS-422

Up to 32 inverters can be connected.

RS-485 terminal block

Personal computer
(FR Configurator2)

GOT2000

RS-422/485

Up to 32 inverters can be connected.

Personal computer
(FR Configurator2)

USB cable

RS-485 terminal block

USB connector

PU connector

Terminating
resistor

Station
number 1

Station
number 2

Station
number n

10BASE-T cable

GOT1000

RS-422

Distributor

GOT RS-422
communication unit

USB connector/ 
Serial port

USB/serial cable

Personal computer
(FR Configurator2)

Distributor Distributor

RS-422/485

GOT2000

Personal computer
(FR Configurator2)

USB connector
USB cable

PU connector

Terminating
resistor

Station
number 1

Station
number 2

Station
number n

10BASE-T cable

Distributor Distributor Distributor
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Connection and parameter setting

1

NOTE
 • Do not perform the following operation while the FA transparent function is valid and FR Configurator2 is ONLINE.

Online operation (project download, etc.) from GT Designer/GT Designer2 to GOT
Online operation to programmable controller CPU by using FA transparent function of GX Developer or GX Works2

 • When using FA transparent communication, communication error (timeout) may occur when FR Configurator2 starts 
communication during timeout occurrence in GOT (when GOT is monitoring the inverter which is not connected). In that 
case, set the timeout time value more than the following. (Refer to page 36.)
Timeout value of GOT [s]  (Retry count of GOT + 1) 
If the value above is more than 30 [s], make adjustment to "Timeout value" [s] and "Retry count" of GOT to make the value 
above become less than 30 [s].

GOT2000 series automatic recognition
 • When the GOT2000 series is connected, the parameters required for the GOT connection are automatically changed by 

setting the automatic recognition on the GOT2000 series side.
 • Set the station number (Pr.117 or Pr.331) of the inverter before the automatic recognition is performed.
 • Connect all the stations of inverters with GOT before the automatic recognition is performed. The inverter newly added after 

automatic recognition will not be recognized automatically. (When an inverter is added, perform the initial setting in Pr.999 
Automatic parameter setting or set the automatic recognition on the GOT side again.)

NOTE
 • If the automatic recognition cannot be performed, initial setting in Pr.999 is required.
 • For connection to a device other than the GOT2000 series, initial setting in Pr.999 is required.
 • For details, refer to the GOT2000 Series Connection Manual (Mitsubishi Product) (SH-081197ENG).

Automatic change 
item

Automatic change parameter setting
Setting value after changePU connector 

connection
RS-485 terminal 

connection
Communication speed Pr.118 Pr.332

Depending on the setting of the 
connected device on the GOT side.

Data length/stop bit Pr.119 Pr.333

Parity Pr.120 Pr.334

Waiting time setting Pr.123 Pr.337

CR/LF selection Pr.124 Pr.341

Number of communication 
retries Pr.121 Pr.335 9999 (fixed)

Communication check time 
interval Pr.122 Pr.336 9999 (fixed)

Protocol selection
- (Pr.549 holds the value 
before the automatic 
recognition.)

Pr.549 0 (fixed to Mitsubishi inverter protocol)
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Connection and parameter setting
Related parameters for connection through GOT
Set communication-related parameters automatically as follows. For connection through GOT, set Pr.123 PU 
communication waiting time setting = "0", Pr.337 RS-485 communication waiting time setting = "0". For connection to 
the PU connector, set Pr.999 Automatic parameter setting = "12". For connection to the RS-485 terminals, set Pr.999 = 
"13".
 • List of related parameters

Pr. Name Initial value Setting 
range Description

117
N020

PU communication station 
number 0 0 to 31 

Set the inverter station numbers.
The inverter station number setting is required when 
multiple inverters are connected to one personal 
computer.

118
N021 PU communication speed 192

48, 96,
192, 384,
576, 768, 
1152

Set the communication speed.
The setting value  100 equals the communication 
speed.
For example, the communication speed is 19200 bps 
when the setting value is "192".

N022 PU communication data length 0
0 Data length: 8 bits

1 Data length: 7 bits

N023 PU communication stop bit 
length 1

0 Stop bit length: 1 bit

1 Stop bit length: 2 bits

119 PU communication stop bit 
length / data length 1

0 Stop bit length: 1 bit
Data length: 8 bits

1 Stop bit length: 2 bits

10 Stop bit length: 1 bit
Data length: 7 bits

11 Stop bit length: 2 bits

120
N024 PU communication parity check 2

0 Without parity check

1 With odd parity

2 With even parity

121
N025

Number of PU communication 
retries 1

0 to 10

Set the permissible number of retries for 
unsuccessful data reception. If the number of 
consecutive errors exceeds the permissible value, 
the inverter trips.

9999 Even if a communication error occurs, the inverter will 
not trip.

122
N026

PU communication check time 
interval 9999

0 PU connector communication is disabled.

0.1 to 999.8 s

Set the communication check (signal loss detection) 
time interval.
If a no-communication state persists for longer than 
the permissible time, the inverter trips (depends on 
Pr.502).

9999 No communication check (signal loss detection).

123
N027

PU communication waiting time 
setting 9999

0 to 150 ms Set the waiting time between data transmission to the 
inverter and response.

9999 Set with communication data.

124
N028

PU communication CR/LF 
selection 1

0 Without CR/LF

1 With CR

2 With CR/LF

331
N030

RS-485 communication station 
number 0 0 to 31 (0 to 

247)
Sets the inverter station number.
(the same specifications as Pr.117)

332
N031 RS-485 communication speed 96

3 to 6, 12 to 
24, 48, 96, 
192, 384, 576 
to 768, 1152,

Select the communication speed.
(the same specifications as Pr.118)

N032 PU communication data length 0 0, 1 Select the data length. (the same specifications as 
P.E022)
26 OUTLINE



Connection and parameter setting

1

 Set Pr.549 = "0" (Mitsubishi inverter (Computer link) protocol).
 Pr.551 can be always written regardless of the operation mode.
 With the Modbus-RTU protocol, the data bit length is fixed at 8 bits.
 With the Modbus-RTU protocol, the stop bit length is depending on the Pr.334 setting.
 With the Modbus-RTU protocol, the setting is invalid.
 The read value is always "9999".

NOTE
 • Always perform an inverter reset after performing the initial setting of each parameter. After changing the communication-

related parameters, communication cannot be made until the inverter is reset.

N033 PU communication stop bit 
length 1 0, 1 Select the stop bit length. (the same specifications as 

P.E023)

333 RS-485 communication stop bit 
length / data length 1 0, 1, 10, 11 Select the stop bit length and data length. (the same 

specifications as Pr.119)

334
N034

RS-485 communication parity 
check selection 2 0, 1, 2

Select the parity check specifications.
(the same specifications as Pr.120)

335
N035

RS-485 communication retry 
count 1 0 to 10, 9999

Set the permissible number of retries for 
unsuccessful data reception. (the same specifications 
as Pr.121)

336
N036

RS-485 communication check 
time interval 0 s

0
RS-485 communication is enabled. However, the 
inverter trips if operation is changed to NET operation 
mode.

0.1 to 999.8 s Set the communication check (signal loss detection) 
time interval. (the same specifications as Pr.122)

9999 No communication check (signal loss detection).

337
N037

RS-485 communication waiting 
time setting 9999 0 to 150 ms

9999

Set the waiting time between data transmission to the 
inverter and response. (the same specifications as 
Pr.123)

341
N038

RS-485 communication CR/LF 
selection 1 0, 1, 2 Select presence/absence of CR/LF.

(the same specifications as Pr.124)

549
N000 Protocol selection 0

0 Mitsubishi inverter (computer link) protocol

1 Modbus-RTU protocol

551
D013 PTC thermistor protection level 9999

1 The RS-485 terminals are the command source when 
in the PU operation mode.

2 The PU connector is the command source when in 
the PU operation mode.

3 The USB connector is the command source when in 
the PU operation mode.

9999

USB automatic recognition
Normally, the operation panel (PU connector) is the 
command source. When the USB is connected, the 
USB connector is the command source.

999
E431 Automatic parameter setting 9999

1 Standard PID setting

2 Extended PID setting

10 GOT initial setting
(PU connector) GOT side model selection: 

FR 500/700/800, 
sensorless servo11 GOT initial setting

(RS-485 terminals)

12 GOT initial setting
(PU connector) GOT side model selection: 

FR 800
Automatic setting13 GOT initial setting

(RS-485 terminals)

20 50 Hz rated frequency

21 60Hz rated frequency

9999 No action

Pr. Name Initial value Setting 
range Description
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Setting of operation mode of the inverter
1.5 Setting of operation mode of the inverter
The inverter has three operation modes.

External operation mode: Operation and frequency commands are given by an external potentiometer and switches, via 
control circuit terminals.
PU operation mode: Operation and frequency commands are given by the operation panel (FR-DU08), parameter unit (FR-
PU07), or RS-485 communication, via the PU connector.
Network operation mode (NET operation mode): Operation and frequency commands are given via the RS-485 terminals 
or a communication option.

Pr. 79
setting

Operation mode at power ON, at 
power restoration, or after a reset. Operation mode switchover

0
(initial 
value)

External operation mode Switching among the External, PU, and NET operation mode is 
enabled. 

1 PU operation mode PU operation mode fixed.

2 External operation mode
Switching between the External and NET operation mode is 
enabled.
Switching to PU operation mode is disabled.

3, 4 External/PU combined operation mode Operation mode switching is disabled.

6 External operation mode Switching among the External, PU, and NET operation mode is 
enabled while running.

7

X12 (MRS) signal ON...External operation 
mode

Switching among the External, PU, and NET operation mode is 
enabled. 

X12 (MRS) signal OFF...External operation 
mode

External operation mode fixed. (Forcibly switched to External 
operation mode.)

 Operation mode cannot be directly changed between the PU operation mode and Network operation mode.

∗When using USB connection, operation mode changing is available from FR Configurator2.

Switching through the network

Switch to Network operation
mode through the network.

Press           on
the PU to lightPress            on

the PU to light

Switch to External
operation mode through
the network.

External operation

Switching with the PU

Press           on the PU to light

Network operation PU operation

Press           on the PU to light

Network operation

When "0 ,1 or 2" is set in Pr. 340

When "10 or 12" is set in Pr. 340
PU operation

(Refer to page 49 , 75)
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Setting of operation mode of the inverter

1

Refer to the following table to select the appropriate operation mode for the connection.  Switching of the operation mode is 
available using "test operation" (on page 75) or "parameter list" (on page 49) on the sub window.
Refer to the Instruction Manual (Detailed) of the inverter for details of each parameter.

Controllability through communication
 • Monitoring and parameter read can be performed from any operation regardless of the operation mode.

Operation
location

Condition
(Pr. 551 
setting)

Operation
mode

Item

PU
operation

External
operation

External/
PU

combined
operation
mode 1

(Pr. 79 = 3)

External/
PU

combined
operation
mode 2

(Pr. 79 = 4)

NET 
operation

(when 
RS-485

terminals)

NET operation
(with

communication
option)

   
   

   
   

   
C

on
tro

l b
y 

R
S

-4
85

 c
om

m
un

ic
at

io
n 

vi
a 

PU
 c

on
ne

ct
or

2
(PU 
connector)
9999
(automatic 
recognition, 
without USB 
connection)

Run command 
(start)     

Run command 
(stop)     

Running frequency 
setting     

Monitor     

Parameter write     

Parameter read     

Inverter reset     

Other than
the above

Run command 
(start)     

Run command 
(stop)     

Running frequency 
setting     

Monitor     

Parameter write     

Parameter read     

Inverter reset     

   
   

 C
on

tro
l b

y 
co

m
m

un
ic

at
io

n 
vi

a 
R

S
-4

85
 te

rm
in

al
s

1
(RS-485
terminals)

Run command
(start, stop)     

Running frequency 
setting     

Monitor     

Parameter write     

Parameter read     

Inverter reset     

Other than
the above

Run command
(start, stop)      

Running frequency 
setting      

Monitor      

Parameter write      

Parameter read      

Inverter reset      
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Setting of operation mode of the inverter
 As set in Pr.338 Communication operation command source, Pr.339 Communication speed command source.
 At occurrence of RS-485 communication error from PU connector, the inverter cannot be reset from the computer.
 Enabled only when stopped by the PU. At a PU stop, PS is displayed on the operation panel. As set in Pr.75 Reset selection/disconnected PU 

detection/PU stop selection.
 Some parameters may be write-disabled according to the Pr.77 Parameter write selection setting and operating status.
 Some parameters are write-enabled independently of the operation mode and command source presence/absence. When Pr. 77 = "1", write is 

enabled. Parameter clear is unavailable.
 When Pr.550 NET mode operation command source selection = "1" (RS-485 terminals valid) or Pr.550 NET mode operation command 

source selection = "9999" and the communication option is not mounted.
 When Pr.550 NET mode operation command source selection = "0" (communication option valid) or Pr.550 NET mode operation 

command source selection = "9999" and the communication option is mounted.

   
   

   
   

   
 O

pe
ra

tio
n 

vi
a 

th
e 

U
S

B
 c

on
ne

ct
or

3 (USB
connector)
9999
(automatic 
recognition, 
with USB 
connection)

Run command
(start, stop)     

Running frequency 
setting     

Monitor     

Parameter write     

Parameter read     

Inverter reset     

Other than
the above

Run command
(start, stop)     

Running frequency 
setting     

Monitor     

Parameter write     

Parameter read     

Inverter reset     

C
on

tro
l b

y 
co

m
m

un
ic

at
io

n
fro

m
 c

om
m

un
ic

at
io

n 
op

tio
n

—

Run command
(start, stop)      

Running frequency 
setting      

Monitor      

Parameter write      

Parameter read      

Inverter reset      

E
xt

er
na

l t
er

m
in

al
 a

t t
he

 c
on

tro
l c

irc
ui

t

—

Inverter reset      

Run command
(start, stop)     

Running frequency 
setting     

: Enabled, : Disabled, : Some are enabled

Operation
location

Condition
(Pr. 551 
setting)

Operation
mode

Item

PU
operation

External
operation

External/
PU

combined
operation
mode 1

(Pr. 79 = 3)

External/
PU

combined
operation
mode 2

(Pr. 79 = 4)

NET 
operation

(when 
RS-485

terminals)

NET operation
(with

communication
option)
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1.6 Start and close of FR Configurator2

1.6.1 Starting FR Configurator2
There are the following ways to start FR Configurator2.

 • Start from Start menu
Click [Start] on the Taskbar of Windows, and point to [All Programs], [MELSOFT Application], [FR Configurator2], and 
select [FR Configurator2] in the sub menu to start FR Configurator2.

 • Start from the project file (*.frc2)
(Refer to page 43 for the project file (*.frc2).)

 • Select the project file (*.frc2) and execute it (or press the Enter key). The project file settings will be read and FR 
Configurator2 will be started.

 • Drag and drop the project file to the execution file (FR2.exe) or to the shortcut icon of FR Configurator2. FR 
Configurator2 will be started.

 • Start from Windows Explorer
Select the executable file of FR Configurator2 (FR2.exe) by using Windows Explorer, and double-click (or hit Enter key) to 
start FR Configurator2.

NOTE
 • The following window may appear at the start up of FR Configurator2. If the window appears, select "Allow ".

 • In an operation system with antivirus/security software, a warning may appear at starting FR Configurator2. If a warning 
appears, permit FR Configurator2 according to the setting procedure of your antivirus/security software.

 • If files shown in [Recent Items] of Windows Vista and [Recent] of Windows 7, Windows 8 or Windows 8.1 are stored in 
system folders (Program Files for example), the files may not be opened correctly.

Select "Allow"
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1.6.2 Closing FR Configurator2
Close FR Configurator2 in the following procedure.
Select [Exit] in [File] menu to close FR Configurator2.
(Press Alt + P to open [Project] menu, and press Ctrl + F4 also to close FR Configurator2)

NOTE
 • If a project file (*.frc2) is not saved yet when closing FR Configurator2, the dialog box is displayed to confirm the closing.

手動  

 

Yes? No?
Cancel?

Yes? No?

[Save As]

Save? Cancel?

Save the project file 
(*.frc2) and exit.

Main frame

Exit FR Configurator2

Exit
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2 PROJECT 
CREATION

This chapter explains the "PROJECT CREATION".
Always read the instructions before using the equipment.

2.1 Project file operation ...................................................................................... 34
2.2 Explanation of the operating window of FR Configurator2 ........................ 37
2.3 File operation and print .................................................................................. 43



Project file operation
2.1 Project file operation

2.1.1 Procedure to create a project
The following shows the procedure from creating project to operating the functions of FR Configurator2.

Starting FR Configurator2

Operation Function made available after performing the operation

Starting FR Configurator2

Developer (Refer to page 77)

USB memory parameter copy file edit (Refer to page 89)

Help(Refer to page 92)

System setting window

System setting window(Refer to page 35)

New project

Parameter list (Refer to page 48) Graph(Refer to page 53)

Batch monitor (Refer to page 69) Diagnostics(Refer to page 73)

Test operation (Refer to page 74)

Exit
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2.1.2 Creating a new project file
Enter information required for creating a project file on the "System setting" window.
Select [New] in the [Project] menu or click  on the toolbar to display the "System setting" window.

Symbol Name Function / description
A System name Enter the name of the system within 32 characters.

B Connection setting Set the connection type in [PC-side port], [Port No.], [Through], and [Detailed setting].

C Model setting

• For manual recognition
Select the model, capacity, and connection option of the inverter from the list.
• For automatic recognition
Select "Auto recognize" to enable FR Configurator2 to recognize the information about the connected 
inverter.

D OK Applies the setting to the project and closes the "System setting" window.

E Cancel Closes the "System setting" window without applying the setting to the project.

A

D

B

C

E
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2.1.3 Connection setting
In the "Connection setting" of the "System setting" window, set the communication between the personal computer and 
inverter, etc.
For communication with the inverter using the USB port of personal computer, set "USB" in the box of "PC-side port".
For communication with the inverter using the serial port of personal computer, set "COM*" in the box of "PC-side port".

NOTE
 • To use the USB/RS-485 conversion cable DINV-U4, select [COM*: DTC DINV-U4 USB Serial Port (COM*)] for the PC-side 

port.

Detailed setting
Select [Detailed setting] in the "System setting" window to open the "Detailed setting" window. The connection setting is in 
accordance with the initial value of the inverter.
Check the PC-side port (serial port/USB) and the port number (1 to 63) of the personal computer.

Symbol Name Initial
value Function / description

A Timeout 1000
Set the time after transmitting data from the personal computer to the inverter until the 
personal computer receives a response from the inverter. When no response comes after the 
set time elapsed, the error of "timeout occurs" is displayed.

B Communication 
speed 19200 Set the communication speed. (Refer to Pr.118 and Pr.332.)

C Data length 8 Set the data bit length. (Refer to Pr.119 and Pr.333.)

D Stop bit 2 Set the stop bit length. (Refer to Pr.119 and Pr.333.)

E Parity Even Specify the parity bit. (Refer to Pr.120 and Pr.334.)

F Delimiter CR Specify the delimiter at the end of the data. (Refer to Pr.124 and Pr.341.)

G Restore initial value — A button to return the communication setting to the initial value of the inverter.

H OK — Proceeds to the "System setting" window. (Refer to page 35.)

I Cancel — Clears the setting and closes the "Detailed setting" window.

E

A

B

H IG

D
C F
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2.2 Explanation of the operating window of FR 
Configurator2

This section explains the screen configuration of FR Configurator2.

2.2.1 Main frame
The main frame (main screen) of FR Configurator2 consists of two areas.

 • Project tree area (Refer to page 38)
An area for showing information of the registered inverter, or for making settings. "System setting", "Graph", and "Batch 
monitor" are available in this area.

 • Sub-window area (Refer to page 39)
An area for showing obtained monitor data of the inverter. "Parameter list", "Graph", "Batch monitor", and "Faults history" 
are available in this area.

Symbol Name Function / description Refer to 
page

A Menu bar The window of each function is displayed from the menu bar.
40

B Toolbar The window of each function is displayed in the sub-window area by selecting an icon on 
the toolbar.

C Status bar The model name, operating status, etc. are displayed. 42

D Split line Adjustment of the project tree area size and sub-window area size is available. —

Project tree area

A
B

Sub-window area

C

D
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2.2.2 Project tree area
The project tree area displays a list of the project data including "Parameter list" of the inverters registered in the project, 
"System setting", "Graph", and "Batch monitor". Select such an item to display the window in the sub-window area.

 • Details of the project tree area

Display and switching of the project tree area
Select [Project window] from [Docking Window] in the [View] menu to switch the display of the project tree area among 
display, tab display, and hidden.

Symbol Name Function / description
A Project name Displays the project name.

B System setting Displays the system setting window in the sub-window area.

C Graph Displays the graph window in the sub-window area.

D Batch monitor Displays the batch monitor screen in the sub-window area.

E Station number: 
inverter model

Displays the station number and the model of the inverter registered in the project.
Click "Station number: inverter model" to select the corresponding station number. The selected 
"Station number: inverter model" is highlighted in yellow. (If the main frame is not selected, "Station 
number: inverter model" is displayed in gray.)
Click  on the left of the icon to spread the tree view and display [Parameter].

F Parameter Click [Parameter] to display the "parameter list" in the sub window area.

A
B
C
D
E

F

Normal display Dock display when unpinned

When pinned, 
only the tab is 
displayed.

Click the tab to 
display the dock.

When unpinned, 
whole dock is displayed.

Pinned

Show/hide switching pin
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2.2.3 Sub-window area
The sub-window area is for displaying, reading, and writing parameters, and for displaying the information read from the 
inverter.

Select a function in the [Window] menu or click an icon on the toolbar to switch the windows in the sub-window area.

Symbol Name Function / description

A Tab

Displays the names of functions in tab format.
Click a tab to move the corresponding sub window to the front and operate it.
Drag a tab to change the order of the sub windows.
Click the  button on the tab to close the corresponding sub window.
(When the window cannot display all the tabs, the tabs can be scrolled by the button.)

B Sub-window selection button Displays a list of the displayed sub windows. Select a sub window from the list to display it 
front.

C Sub-window display area Displays a function window of FR Configurator2.

B

A

C
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2.2.4 Menu bar and toolbar
The window of a desired function can be displayed by selecting it from the menu or on the toolbar.

Menu/Toolbar list
The following functions are available on the menu.

Menu Pull-down menu Toolbar 
icon Function / operation

Project

New... Displays the system setting window.

Open... Opens a project file (*.frc2).

Close... — Closes the project file (*.frc2).

Save
Saves the project file (*.frc2). When the project file (*.frc2) has not 
been read or not created yet, the "Save As" window is displayed 
to save the project file.

Save As... — Names the current setting and saves it as a project file (*.frc2).
System setting — Used to check and change the system setting.
Print preview — Used to check the print screen of the selected sub window.

Print... Prints the selected sub window.

Exit FR Configurator2 — Exits FR Configurator2.

View

System — Shows or hides the system toolbar.
Call function — Shows or hides the call function toolbar.
Status bar — Shows or hides the status bar.

Docking Window Project window Shows or hides the project window.

File

Open... Opens a file related to the function of the sub window that is 
displayed front.

Import...
Imports files (*.gp4 or *.st1) when the graph window is opened. 
Use this function to compare them with the previous waveform 
data by displaying them together.

Save As... Saves the data related to the function of the sub window that is 
displayed front as new data with a name.

Save image in file... Saves the graph window as graph data (*.jpg or *.emf) when the 
graph window is opened.

Parameter list 
(Z)

PU — Activates the PU operation mode.
EXT — Activates the External operation mode.
NET — Activates the NET operation mode.

Batch read Reads all the set values of the parameters of the selected 
inverter.

Read Reads the set value of the selected parameter of the selected 
inverter.

Batch write Writes all the parameter setting values entered in the setting field 
to the selected inverter.

Write Writes the set value of the selected parameter to the selected 
inverter.

All clear
Returns all parameters which can be cleared including calibration 
parameters and terminal function selection parameters to their 
initial values.

Parameter clear Returns parameters excluding calibration parameters and 
terminal function selection parameters to their initial values.

Verify Verifies the set values of the parameters set in FR Configurator2 
with those of the parameters written in the inverter.
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Batch monitor 
(Z)

Pause Pauses the acquisition of the monitor data.

Resume Resumes the acquisition of the monitor data.

Setting... Sets the monitored item to be displayed.

Graph (Z)

Screen copy Saves the entire sub window as image data (*.bmp) to the 
clipboard.

Scale optimization
Adjusts the scale of the vertical axis and the position of zero so 
that the entire waveform of the selection history can be displayed 
in the window.

Moving mode Used to scroll the displayed waveform data.

Zoom-in mode Used to zoom in the specified area of a waveform.

Cursor Shows or hides the cursor on the screen.

Grayout Switches the display color (color or gray scale) of the waveform 
and the graph on the screen.

Overwrite Enables or disables overwriting for all the histories.

History management... Shows or hides the waveform history screen.

Property window
Setting — Shows or hides the setting tab.
Indication — Shows or hides the indication tab.
Cursor — Shows or hides the cursor tab.

Faults history 
(Z)

Faults history clear Clears the faults history of the inverter.

Inverter reset Resets the inverter.

Operation mode 
(Z)

PU — Activates the PU operation mode.
EXT — Activates the External operation mode.
NET — Activates the NET operation mode.

Parameter Parameter list... Displays the "Parameter list" window in the sub-window area.

Diagnose Faults history — Displays the "Faults history" window in the sub-window area.

Monitor
Graph... Displays the "Graph" window in the sub-window area.

Batch monitor... Displays the "Batch monitor" window in the sub-window area.

Test operation Test operation... Shows or hides the command sending section of "Test 
operation".

Tool

Developer... Starts Developer.

USB memory parameter copy file 
function edit Starts the USB memory parameter copy file editor.

Window

Cascade — Cascades sub windows.
Tile horizontally — Tiles sub windows horizontally.
Tile vertically — Tiles sub windows vertically.
Arrange icons — Arranges sub windows that are displayed as icons.
Close all — Closes all the sub windows.

Reset window layout — Resets the layout and the sizes of the toolbar, docking windows, 
and sub windows to each initial status.

Opened sub window
(Example) Parameter list 1 — Select this item to display the opened sub window.

Menu Pull-down menu Toolbar 
icon Function / operation
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 The function menu related to the front sub window is displayed. When no sub window is displayed in the sub-window area, these items are not 
displayed on the menu bar.

Communication management
Online/offline can be switched for communication between FR Configurator2 and the inverter from the menu on the toolbar.

The online/offline condition of communication between FR Configurator2 and the inverter can be checked by the icon that is 

displayed.

2.2.5 Status bar
The status bar displays the operation mode of the inverter, the model information etc.

 • Keyboard status list

Help
FR Configurator2 help... Starts the help.

Version information... — Opens the "Version information" window.

Display Status

offline

online

Symbol Name Function / description

A Window status display Displays the function description when the mouse cursor is on an item on the menu bar or an icon 
on the toolbar.

B Station information Displays the model information of the inverter that is selected in the project tree.
The display format is "Station number: Inverter model".

C Keyboard status Displays the keyboard status.

Item
Character color

Black Gray
"CAP" Caps Lock: ON Caps Lock: OFF

"NUM" Num Lock: ON Num Lock: OFF

Menu Pull-down menu Toolbar 
icon Function / operation

A B
C
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2.3 File operation and print

2.3.1 List of file types

2.3.2 Open the file
Saving a project file
This function reads the information of each function window that is saved in a project file (*.frc2), such as model information 
and parameter setting values, and reflects it to the windows.

Select [Open] in the [Project] menu or click  on the toolbar to display the "Open the file" window. To read a saved file, 

select the target file, then press the [Open] button.
Regardless whether each function window is shown or hidden, the information of the opened file is reflected to FR 
Configurator2.

Open the file of each function
The information of files having an extension *.gp4, *.pr4, or *.cp1 can be imported and displayed on the screen by selecting 

[Open...] in the [File] menu or  on the tool menu of each function window while the corresponding function window is 

displayed. 

2.3.3 Save the file
Select [Save As] in the [Project] menu or the [File] menu to display the "Save As" window. Check the save destination, name 
a file, and save it.
Select [Save] in the [Project] menu or the [File] menu to overwrite the file. When saving a file for the first time, "Save As" 
window is displayed.

NOTE
 • If the project file (*.frc2) needs to be shared with another user, place it in the folder that another user can access.

Extension Description Corresponding 
window Open Save Import

Refer 
to 

page

*.frc2
Manages the system setting, model information, 
parameter list, sampling data of graph, and data of the 
batch monitor with a single file.

All window    35

*.gp4
Holds the waveform data sampled by the graph 
function. The saved waveform data can be displayed 
again by opening the file with the graph function.

Graph

   55

*.csv Holds the waveform data sampled by the graph 
function in the text file format.    55

*.st1 Holds the operating status of the inverter in a USB 
memory tracing it.    55

*.jpg Holds the waveform data of the displayed graph 
window as an image file.

   55
*.emf    55

*.pr4 Holds the parameter setting values set in FR 
Configurator2. Parameter list

   49

*.xls Holds Parameter List data in Microsoft Excel format.    49

*.cp1 Holds the parameter setting that has been copied 
from the inverter to a USB memory device.

USB memory 
parameter copy file 
edit

   89

(: Available,  : Unavailable)
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2.3.4 Import the data
By importing the saved data (*.gp4) of the "Graph", the information of the data can be displayed on the "Graph" sub window.
Select [Import] in the [File] menu to display a window for selecting the importing file.

2.3.5 Print
The windows of "Parameter List" or "Graph" can be printed. Select [Print...] in the [Project] menu or click  on the toolbar.

The parameter list is printed in the following format.

NOTE
 • The comments entered in the system setting window are printed in the comment field of the parameter list.

Symbol Name Function / description
A Name Select a printer.

B OK Click to start printing.

C Cancel Cancels the printing, and closes the window.

D Properties Displays a printer property window of the selected printer.

Printing example of a parameter list Printing example of a verification list

A

D

CB
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The Graph is printed in the following format.

NOTE
 • The graph drawing area is printed in black. To print the area in white, turn ON the grayout setting before printing.
 • The displayed position in the print preview may differ from the actual printed position on a print.

2.3.6 Print preview
The printing image of the "parameter list" window or "graph" window can be displayed in the sub window before printing. 
Select [Print preview] in the [Project] menu.

                               Example of the Graph print

Symbol Name Function / description
A Print... Click to start printing.

B Next Page Displays the next page when the print target has two pages or more.

C Prev Page Displays the previous page when the print target has two pages or more.

D
Two Page Displays two pages on one window when the print target has two pages or more.

One Page Displays one page on one window when the print target has two pages or more.

E Zoom In Enlarges the display of the print preview by three steps.

F Zoom Out Reduces the display of the print preview by three steps.

G Close Closes the print preview window.

A B C GD E F
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This chapter explains the "Functions" of this product.
Always read the instructions before using the equipment.

3.1 Parameter list .................................................................................................. 48
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3.3 Batch monitor.................................................................................................. 69
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3.5 Test Operation................................................................................................. 74
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3.7 USB memory parameter copy file edit function........................................... 89
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Parameter list
3.1 Parameter list
The following functions can be performed using the "Parameter list".

 • Parameter display
 • Parameter setting value read, batch read
 • Parameter setting value input, write, batch write
 • Parameter clear / all parameter clear
 • Parameter verify 
 • Parameter search

To display the "Parameter list", select [Parameter list...] in the [Parameter] menu, or the "Parameter list" can be displayed by 

clicking  on the toolbar. "Parameter list" cannot be displayed if no project file has been created, or if no project file is 

open.

The available "Parameter list" functions are different at online and offline. 

NOTE
 • FR Configurator2 parameter list supports the latest inverter at the time of  FR Configurator2 upgrade. The setting range, initial 

value, number of parameters, etc., may be different with the inverter before upgrading (additional functions).
 • Although the parameter name of the instruction manual and the parameter name of FR Configurator2 may be different, there 

is no difference in the parameter function.
 • Pr.296 and 297 do not appear in the parameter list. Pr.296 and 297 will not change even if parameter settings of another 

inverter are read. Change Pr.296 and 297 from the operation panel or the parameter unit.

Function Online Offline
All parameter clear  

Parameter clear  

Batch read  

Read  

Batch write  

Write  

Verify  

Parameter setting value input  

Undo  

Redo  

Search  

(: operation available; : operation not available)
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3.1.1 Parameter list

Symbol Name Function / description

A St. No. (Station 
number) Selects a station registered in the project.

B Operation mode 
switch The inverter operation mode can be switched by selecting the operation mode button.

C Operation mode 
indication Shows the operation mode.

D Batch read Reads all the parameter setting values of the selected inverter.

E Read Reads the selected parameter setting values of the selected inverter.

F Batch write Writes all the selected parameter setting values in the setting value column to the selected inverter.

G Write Writes all selected parameter setting values to the selected inverter.

H All clear Returns all parameters which can be cleared including calibration parameters and terminal function 
selection parameters to their initial values.

I Parameter clear Returns parameters excluding calibration parameters and terminal function selection parameters to 
their initial values.

J Verify Verifies the parameter settings, initial values and parameter files (*.pr4) set in FR Configurator2 
against such settings already written to the inverter.

K Open Displays the "Open" dialog box for a parameter file (*. pr4) to be opened.

L Save as

Shows the "Save as" dialog box. Verifies the save location, and saves with the specified [File Name]. 
The extension for savable parameter information files is *.pr4.
The parameter list data can also be saved in the Microsoft Excel file format (*. xls) by using "File Type" 
in the "Save as" dialog box.

M Undo Returns the edited parameter setting value to the setting value before editing.

N Redo Redoes the setting value changed by "Undo".

O Search Searches for the input character string from within the parameter list.

P Back Searches for the input character string in the downward direction.

Q Next Searches for the input character string in the upward direction.

R Target item Specifies the column to search.

B
C

J
R

D E F G
H

I
A

K

L M N O P Q
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• Parameter list display item

NOTE
 • To display the explanation about a parameter on the help window, double-click the parameter in the parameter list.

3.1.2 Parameter clear / all parameter clear
Performing parameter clear or all parameter clear will return the parameters to the initial values.
By selecting [All clear] or [Parameter clear] in the [Parameter list (Z)] menu, or by selecting [All clear] or [Parameter clear] from 
the toolbar, the confirmation dialog will be displayed, and parameter clear or all parameter clear will be executed. Refer to the 
Instruction Manual of the inverter for availability of parameter clear and all parameter clear for each parameter.

NOTE
 • If parameter clear or all parameter clear is performed from FR Configurator2, clearing of the following communication 

parameters is not performed. For details regarding each parameter, refer to the Instruction Manual (Startup) for the inverter or 
the instruction manual for the communication option.
Pr.117 to Pr.124, Pr.331 to Pr.341, Pr.345, Pr.346, Pr.349, Pr.541 to Pr.544, Pr.547 to Pr.549

3.1.3 Parameter read (batch read) and write (batch 
write)

Parameter read and write can be performed by accessing the inverter parameters. By selecting from among [Batch read], 
[Read], [Batch write], or [Write] in the [Parameter list (Z)] menu, or by selecting [Batch read], [Read], [Batch write], or [Write] 
from the toolbar, the confirmation dialog will be displayed, and batch read, read, batch write, or write will be performed.
The following window is shown when batch read, read, batch write, or write is finished and an error has occurred.

Item Function / Description

Number Shows the parameter number.
Calibration parameters (Pr.902, 903, 904, 905, etc.) will be shown with ( ).

Name Shows the parameter name.

Setting range Shows the setting range of the parameter setting value.

Minimum setting unit Shows the minimum setting unit of the parameter setting value.

Initial value Shows the factory default parameter setting values of the inverter.

Setting value Inputs the value to be written to the inverter. Selecting [Write] or [Batch write] will write the setting value field data 
to the inverter.

B

D

A

C

E
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NOTE
 • If the setting value of Pr.342 is changed from "0" to "1" by batch writing, only the Pr.77 Parameter write selection, Pr.122 PU 

communication check time interval, and Pr.336 RS-485 communication check time interval setting values will be 
written to RAM only. (They will not be written to EEPROM.) To change the setting values for Pr.77, Pr.122, and Pr.336, write 
from the parameter unit or the operation panel.

 • Due to the setting values of Pr.77 Parameter write selection and Pr.79 Operation mode selection, when batch writing 
parameters a write error will occur for Pr.122 PU communication check time interval, Pr.336 RS-485 communication 
check time interval, and Pr.342 Communication EEPROM write selection.

 • For the FR-A820-55K (03160) or FR-A840-55K (01800), changing the Pr.570 Multiple rating setting to the SLD or LD rating 
(Pr.570="0" or "1") does not change the minimum increment and setting range displays of Pr.90 to 94, Pr.458 to Pr.462, 
Pr.859, and Pr.860.
If a setting value is entered in accordance with the displayed minimum increment, the lower digits may be dropped when it is 
written to the inverter.
Example with Pr.90 Motor constant (R1): "0.001" is displayed on the parameter list, but the inverter's minimum setting 
increment is "0.01". If "12.567" is input in this condition, "12.56" is written to the inverter.

Symbol Name Function / description

A Result 
display

Error parameter Shows only the parameters with read errors or write errors.

Read successful
parameter Shows only the parameters successfully read.

Write successful
parameter Shows only the parameters successfully written.

Canceled parameter Shows only the parameters with read or write canceled.

B Station tag Shows the read or write target station.

C Result list
Read Shows parameter number, name, initial value, and error number of the reading error 

parameters.

Write Shows parameter number, name, data, and error number of the writing error 
parameters.

D Help Help appears.

E Close Closes the operation window.
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3.1.4 Parameter verification
This function accesses the inverter parameters, and verifies the parameter setting values set by FR Configurator2 with the 
values selected in the verify destination window.
The "Select destination selection" window can be displayed by selecting [Verify...] in the [Parameter list (Z) ] menu, or by 
selecting [Verify] on the toolbar.

The Verify window appears after selecting the destination on the Verify destination window.

Symbol Name Function / description

A Destination

Initial value Verifies against the initial value.

Inverter Verifies against parameter setting values written to the inverter.

File Verifies against parameter list setting values saved to a file (*.pr4).

B OK Shows the Verify window.

C Cancel Closes the Verify destination selection window without performing verification.

Symbol Name Function / description

A St. No. (Station 
number) Shows the verified station number.

B Verify list Shows parameters whose verified values are mismatched.

A

B C

A

B
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3.2 Graph
The inverter output frequency, current, and other data is sampled, and the result is displayed in a graph (waveform). Sampled 
data can be saved to a file (*.jpg, *.emf, *.gp4, or *.csv file), and sampling data saved to a file can be read (*.gp4 file, or *.st1 
import) and displayed.

The [Graph] window can be displayed by selecting [Graph] from the [Monitor] menu, or by clicking  on the toolbar.

There are two types of sampling methods.

 • High speed sampling
Data is collected with the shortest sampling interval, approx. 0.125 [ms]. The target station of the sampling is only 1 station. 
The high speed sampling is available only during USB connection.

 • Monitor sampling
The sampling interval varies depending on communication settings (communication speed, communication port) and the 
number of sampling items.

 • Trace data display
Displays in the graph window the trace data that is saved to the USB memory by the inverter.

NOTE
 • Running other applications during high speed sampling, or performing personal computer file operations during high speed 

sampling, etc., will cause communication errors (error code 0x80020007 or 0x80020008) or buffer overflow errors to occur, 
and data will not be able to be displayed correctly. In this case, execute such countermeasures as terminating the other 
applications, refraining from operation of FR Configurator2, and increasing the mask count setting of the sampling interval.

 • The sampling interval varies depending on the inverter control method and presence/absence of plug-in options. 

Setting item Specifications

Sampling interval
High speed sampling: Set to between approx. 1 [ms] (mask count: 1) and approx 20 [ms] (mask count: 30)

Monitor sampling: Set to the range from 50 [ms] to 60000 [ms] (varies due to communication speed, 
communication port, and number of sampling items)

Sampling time [ms]
High speed sampling: Maximum = (mask count +1)  4000

Monitor sampling: Maximum = sampling interval  4000

Analog data Analog data for 4 channels can be sampled.

Digital data Digital data for 4 channels can be sampled.

Setting item Specifications
Analog data Analog data for 8 channels can be displayed in the graph window.

Digital data Digital data for 8 channels can be displayed in the graph window.
FUNCTION 53



Graph
3.2.1 Graph window

NOTE
 • If a normal communication with inverter is not maintained (communication error, etc.), the sampling stops.
 • If a fault occurs during sampling, sampling continues.
 • During sampling, other communication tasks such as parameter reading are unavailable.

Symbol Name Function, description
A Toolbar Allows operation of the file, history control, and graph display settings.

B Properties Setting of the measurement conditions, display conditions, and cursor can be done in the properties.

C Sampling item 
column

Displays the contents of the analog CH and digital CH set by [Waveform] in the settings tab of the 
condition properties.

D Measurement start/
stop button

Start Starts sampling.

Stop Stops sampling. This button only appears when operating.

E Graph display area Displays the sampled data in a graph.

F Horizontal axis scroll 
bar Allows scrolling of the displayed section in the graph display area.

G Trigger position Shows the position in which the trigger completes. "T" on the graph horizontal axis denotes measuring 
time period.

D

B

E

F

A

G

C
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3.2.2 Graph window toolbar

Symbol Name Function / description
A Open Opens a file (*.gp4, *.st1).

B Import Imports a file (*.gp4, *.st1). Use to overlay and compare with previously acquired waveform data.

C Save as Saves the file with a different name (*.gp4, *.csv).

D Save image Saves the graph screen as image data (*.jpg, *.emf).

E History management Switches between show/hide of the waveform history window.

F Select history Shows the history number of the displayed graph window.

G Back Changes the order of history numbers displayed in the graph window to ascending.

H Next Changes the order of history numbers displayed in the graph window to descending.

I Overwrite Switches overlaying of the entire history ON/OFF.

J Screen copy Saves the entire sub window to the clipboard as image data (*.bmp).

K Scale optimization In order to fit all of the waveform of the selected history within the window, the scale and 0-point 
position of the drawn waveform's vertical axis are automatically adjusted.

L Grayout Changes the display color of the waveform and the display area of the graph (color/gray).

M Cursor Switches between show/hide of the screen cursor.

N Zoom-in mode Specifies a range of the waveform, and zooms in.

O Moving mode Scrolls the waveform data being displayed.

A

O

B C ED F G H I

J K L M N
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3.2.3 Sampling settings
The sampling settings column can be shown by selecting the [Setting] tab in the property conditions. The time, trigger, station, 
and waveform of the analog CH can be set as analog data, and that of the digital CH can be set as digital data.

Symbol Name Function / description
A Initialize Initializes the sampling settings.

B Mode Sets the measurement mode for sampling.

C Time
Mask count Sets the interval for data sampling measurement.

Measurement time (ms) Displays the maximum time for data sampling measurement.
For details, refer to page 57.

D Trigger Sets the start conditions of the sampling measurement. For details, refer to page 60.

E St. (Station) Selects the station to be set for sampling.

F Wave
Selects the items to be sampled. For analog data, 4 CHs (8 CHs of trace data) can be selected, and for digital 
data, 4 CHs (8 CHs of trace data) can be selected.
For the sampling items, refer to page 58.

G Help area Shows a description of the currently selected item.

H
Show/hide 
switching 
pin

Shows/hides the property window.

I Close Closes the currently-selected tab ([Setting], [Indication], or [Cursor]) of the property window. To open the closed 
tab again, from [Graph (Z)] of the menu bar, choose [Property window] and click the tab to open.

A

H I

B
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Setting range and setting unit of sampling interval and sampling time
 • The setting range of the sampling interval and sampling time are different for high speed sampling and monitor sampling.

 • High speed sampling (only for USB connections)
The sampling interval can be about 0.125 [ms] (mask count 1) to about 20 [ms] (mask count 30). The sampling time can 
be up to "(mask count + 1)  4000". The sampling interval varies depending on the control mode.

 • Monitor sampling
The sampling interval and sampling time changes due to communication settings. The lower limit of the sampling 
interval becomes "sampling items  sampling interval lower limit". Refer to the following table for the sampling interval 
lower limit.

For the sampling interval and sampling time maximum values, minimum values, and setting units sampling intervals set 
under actual measurement conditions, refer to the following table.

 If an alarm trigger is set, the alarm trigger is also counted as a sampling item.
 Even if a sampling time shorter than 3000 [ms] is set, the minimum sampling time of 3000 [ms] applies.

Example: Connected to the serial port with a communication speed of 19200 bps, when monitoring three items of output 
frequency, output current, and output voltage as data items to be displayed in a graph.

Sampling interval lower limit = 100 [ms]

Sampling interval maximum value = 60000 [ms] (60 [s])
Sampling interval minimum value = 100  3 = 300 [ms]

Sampling interval maximum value = 60000  4000 = 240000000 [ms] (approx. 66.67 [h])
Sampling time minimum value = 300  50 = 15000 [ms] (15 [s])

Communication port Communication speed [bps] Sampling interval lower limit
[ms] 

Serial port

4800 250

9600 150

19200 100

38400 100

57600 50

115200 50

USB — 50

Maximum value Minimum value Setting unit

Sampling interval
[ms] 60000 Sampling interval lower limit (table 

above)  number of sampling items 1

Sampling time
[ms] Sampling interval  4000 Sampling interval  50 1
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Sampling item list
 • Items for high speed sampling intervals have " * " attached to the beginning of the name. For details on monitor items, refer 

to the Instruction Manual of the inverter.
For digital data sampling items, refer to the Instruction Manual (Detailed) of the inverter.

Sampling mode

Sampling item

Monitor High speed

Output frequency  

Output current  

Output voltage  

Frequency setting value  

Speed/machine speed  

Motor torque  

Converter output voltage  

Regenerative brake duty    

Electronic thermal O/L relay function 
load factor  

Output current peak value  

Converter output voltage peak value  

Input power  

Output power  

Load meter  

Motor excitation current  

Position pulse  

Cumulative energization time  

Orientation status  

Actual operation time  

Motor load factor  

Torque command  

Torque current command  

Motor output  

Feedback pulse  

PLC function user monitor 1  

PLC function user monitor 2  

PLC function user monitor 3  

PID set point  

PID measured value  

PID deviation  

Motor thermal load factor  

Inverter thermal load factor  

PTC thermistor resistance  

PID measured value 2  

Remote output value 1  

Remote output value 2  

Remote output value 3  

Remote output value 4  

PID manipulated amount  

Second PID set point  

Second PID measured value  
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 Available for the standard model only.

NOTE
 • When changing the sampling setting mode (monitor/high speed), change the sampling items before setting. Because the 

monitor contents change if the mode is changed, unshared sampling items are cleared.
 • When setting sampling items, set analog data (CH1 to CH4) sequentially from the analog data CH1, and digital data (CH1 to 

CH4) sequentially from the digital data CH1.
 • When sampling the voltage input of terminal 2, terminal 4, and terminal 1, Pr.241 Analog input display unit switchover will 

be set to "0" (% display), and the sampled data will be shown as 10 V = 100%.

Example:  If Pr.73 = 1 (Terminal 2 input 0 to 5 V), Pr.241 = 0 (% display)
Sampling data of the graph will be shown at 50% even if 5 V is input to terminal 2.

Second PID deviation  

Second PID measured value 2  

Second PID manipulated amount  

Dancer main speed setting  

*Output frequency  

*U-phase output current  

*V-phase output current  

*W-phase output current  

*Converter output voltage  

*Output current (for all three phases)  

*Excitation current (A)  

*Torque current (A)  

Terminal 2  

Terminal 4  

Terminal 1  

*Excitation current (%)  

*Torque current (%)  

Position command  

Current position  

Droop pulse  

*Output frequency monitor (with sign)  

*Motor rotations par minute  

*Speed command  

*Torque command  

*Motor torque  

*Excitation current command  

*Torque current command  

Sampling mode

Sampling item

Monitor High speed
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3.2.4 Trigger settings
Setting a trigger allows sampling to start when an alarm occurs or sampling item conditions are met.

NOTE
 • Activation of analog data

The trigger will not start if the trigger starting conditions have already been met when [ Start] is selected. If "Rise" is 

selected, the trigger occurs when the set value in "level" is exceeded, and with "Fall", the trigger occurs when the set value 
drops to a level lower than "level".

Example: If trigger start condition is "Rise" and the level is set to "3"

If the level is 4 when sampling starts, the trigger will not start. When changed from less than 3 to 3 or more, the trigger 
conditions are met and sampling will start.

 • If the machine speed is displayed by setting Pr.37 Speed display to a value other than 0
To set the "Output frequency" or "Frequency" as the trigger data, enter the trigger activation machine speed as is to the "level" 
column.

For example, if Pr.37 Speed display is set to "1800" with "Output frequency" as the sampling item, and the trigger is to be 
activated at "900", input "900" as is to the "level" column.

Symbol Name Function / description

A Trigger data

Selects the signal that triggers the start of sampling. The trigger signals are as follows.
• Not used
• Analog CH, digital CH (sampling starts if the sampling items meet the conditions)
• Alarm trigger (sampling starts if an alarm occurs)

B Trigger type

Selects the conditions to determine trigger condition satisfaction from rise or fall. (Only appears when 
trigger data is analog CH or digital CH.)
• Rise
Analog CH: When the value specified by the trigger level is exceeded
Digital CH: When the signal changes from OFF to ON
• Fall
Analog CH: When the value drops to a level lower than the trigger level
Digital CH: When the signal changes from ON to OFF

C Trigger level Sets the threshold to determine trigger condition satisfaction by the analog signal. (Only appears when 
the trigger data is set to Analog CH.)

D Trigger position Sets the ratio of sampling data to collect before the trigger conditions are met. (Only appears when the 
trigger data is set to Analog CH, Digital CH, or Alarm trigger.)

E Col. mode 
(Collection mode)

Sets whether the sampling should be continuously operated.
Single: Sampling is performed only once.
Continuous: Sampling is performed continuously.

B
A

C
D
E
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 • Trigger standby state

Sampling stops when [      Stop]  
is clicked or when the sampling time has 
exceeded.

Click [       Start] 
to move to the pre-trigger state.

Pre-trigger

Waiting for 
trigger

Sampling 

Exit

When trigger conditions are satisfied, 
sampling will start.

Standby Sampling setting and trigger setting are performed.

Data before trigger is being collected.
(Even if the trigger condition is satisfied 
during pre-triggering, sampling will not start.)

Data before trigger has been collected, 
and the system is waiting for the trigger 
conditions to be satisfied.
When trigger conditions are satisfied, 
sampling will start. Data before trigger 
is collected until the trigger conditions are satisfied.

Sampling is performed.
Graph mapping is performed at the same time.

Ends the sampling.

Once the data ratio set at the trigger 
position is collected, it goes to the trigger 
standby state.
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3.2.5 Changing scale and the graph display
The scale and waveform data display of the displayed graph can be changed. The graph's displayed portion can be divided 
into a grid of 10 vertical and 10 horizontal sections. The scale of the vertical axis and the horizontal axis can be changed by 
setting a numerical value for each 1 divided grid.
It is possible to slide and display the selected graph up and down by calibrating of the 0 position.
The scale value displayed on the vertical axis changes according to changes in the vertical axis scale.

Symbol Name Function / description
A Vertical axis scale Changes the vertical axis scale intervals for the analog CH set as sampling items.

B Horizontal axis scale Changes the horizontal axis scale interval based on the set operating time.

C Basic graph color Changes the background color of the graph and the color of the grid lines.

D Waveform color Changes the color of the measured waveform data.

E Help area Shows a description of the currently selected item.

F Cursor bar Adjusts the cursor position.

G Scroll buttons for each analog 
channel Moves up/down the graph waveform data for each analog channel.

H Scroll destination setting 
button

Displays a dialog box to directly input a numerical value for the position of the travelling target 
of the waveform data.

A

C

E

B

D
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H
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 • Reading position setting window
When displaying the trace data (*.st1), which is saved in the recorder mode, on the graph window, the start position and 
end position of the waveform data can be specified. The reading area of waveform data can be specified by sliding pointers 
or entering numerical values into the start position and end position input boxes.

NOTE
 • When opening the the trace data (*.st1) saved in the recorder mode using the graph function, reading of the file may take 

time.

Symbol Name Function / description
A Sampling cycle average value Displays the sampling cycle.

B Reading position setting slide bar Sets the reading start position, the number of reading data points, and the reading end 
position.

C Trigger position Displays the trigger position saved in the trace file.

D Number of all points Displays the number of points sampled and saved in the trace file.

E Start position Set the reading start position for the waveform data in sampling point number.

F Number of points Set the number of sampling points to display in the graph window.

G End position Set the reading end position for the waveform data in sampling point number.

H OK Applies the settings in the read position setting window and reads the trace data.

I Cancel Closes the window without applying the settings of the reading position setting window.

A
C

E F G

D

B
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3.2.6 Cursor function
Displays the numerical value, actual value between any two points, maximum value, and minimum value at the cursor on the 
waveform.

Symbol Name Function / description

A Vertical/
horizontal cursor Specifies cursor A and cursor B as the horizontal axis or the vertical axis.

B Cursor bar Specifies the position between cursor A and cursor B.

C Setting

Data type Selects the analog CH subject to the cursor measurement.

Follow wf. 
(Follow waveform)

ON: Moves the cursor so as not to change the value of the vertical axis or horizontal 
axis scale.
OFF: Moves the cursor so as not to change the position of the graph display area.

D Horizontal axis

A Shows the time (ms) at cursor point A.

B Shows the time (ms) at cursor point B.

B-A Shows the time (ms) between cursor points A and B.

E Vertical axis

A Shows the measured values at cursor point A on the waveform.

B Shows the measured values at cursor point B on the waveform.

A-B Shows the values between cursor points A and B.

F Between area A 
and B

Effective value Calculates and displays the effective value between cursor A and cursor B.

Maximum value Shows the maximum value between cursor A and cursor B.

Minimum value Shows the minimum value between cursor A and cursor B.

G Help area Shows a description of the currently selected item.

A
C
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3.2.7 Displaying history
Data of the past 20 samplings (including the current data) can be saved as history and then displayed. The graph data is 
saved as history data at the time of sampling is stopped. If 20 history data are already present, the oldest data is deleted.
The "History management" window will be displayed by selecting [History management...] from the [Monitor (Z)] menu while 

the graph window is displayed, or by clicking  from the toolbar.

NOTE
 • When continuously sampling, all acquired data will be added sequentially to history, and the next sampling will be performed.
 • When display is several graphs, cursor functions are available only for the currently displayed graph.

Symbol Name Function / description
A Delete Deletes the selected history.

B Delete all Deletes all history. However, protected history will not be deleted.

C History list

History number History is displayed by number from the most recent history. The allowable history 
count limit is 20.

Measurement 
date and time Shows the date and time when sampling was executed.

Memo Comment can be input to be attached to history.

Protection
Prevents the checked history from being deleted by the delete button or by continuous 
sampling.
The maximum allowable history protection is 10.

A B

C
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3.2.8 Graph measurement procedure example
(monitoring output frequency, terminal RUN, and 
terminal FU)

 • If operating without a trigger

(1) Specify the station number to be measured as
the "Tgt. St."(Target station).
Next, from the "Analog 1" column of 'Wave",
select "Output frequency", from "Digital 1" select
"RUN", and from "Digital 2" select "FU".

(2) The sampling interval can be set from
 "measurement interval" in "time",
and the sampling time can be set from
 "measurement time".

(3) Measurement will start by clicking 

[ Start].

(4) Measurement is finished by clicking 

[ Stop], or when the set

 sampling time is elapsed.

(5) The graph display can be adjusted.

(6) Data can be saved to a file by "Save as" (Refer to page 43).

Select "RUN".

Select "Output frequency".

Select "FU".

Select the station to be measured.

Set the sampling time.
Set the sampling interval.

Select "      Start".

Select "      Stop".

Changes the displayed 
position of the vertical
axis scale.

Moves up/down the
digital waveform.

Move up/down the waveform.
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 • If the trigger is set, sampling is started at the rise of the terminal RUN signal, and the measuring includes data from 10% 
before the trigger completion.

NOTE

 • In this example, "Trigger position" is set to "10%". After clicking [ Start], the rise of the terminal RUN signal within 10% of 

the sampling time will be ignored, and measurement will not start.

(1) Specify the station number to be measured as the
"Tgt. St."(Target station).
Next, from the "Analog 1" column of 'Waveform"
select "Output frequency", from "Digital 1" select
"RUN", and from "Digital 2" select "FU".

(2) For trigger settings,
 • Select "Digital CH1" from the "Trigger data" 

column.
 • Select "Rise" from the "Trigger type" column.
 • Select "10%" in the "Trigger position" column.

(3) By clicking [ Start], data before trigger

occurrence (10% of sampling time) will be collected.

(4) Measurement automatically starts if the trigger
conditions are met (rise of the terminal RUN signal).

(5) Measurement is finished when 

[ Stop] is clicked, or when the set sampling time
is elapsed. 

(6) The graph display can be adjusted.

(7) Data can be saved to a file by "Save as" (Refer to page 43).

Select "RUN".

Select "Output frequency".

Select "FU".

Select the station to be measured.

Select "Digital CH 1".
Select "Rise".
Select "10".

Select "       Start".

Select "      Stop".

Changes the displayed 
position of the vertical
axis scale.

Moves up/down the
digital waveform.

Move up/down the waveform.
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 • If the alarm trigger is set, sampling is started due to an alarm occurrence, and the measuring includes data from 90% 
before the alarm occurrence.

NOTE

 • In this example, "Trigger position" is set to "90%". After selecting [ Start], alarms within 90% of the sampling time will be 

ignored, and measurement will not start

(1) Specify the station number to be measured as the
"Tgt. St."(Target station).
Next, from the "Analog 1" column of 'Waveform"
select "Output frequency", from "Digital 1" select
"RUN", and from "Digital 2" select "FU".

(2) For trigger settings, perform the following:
 • Select "Alarm trigger" from the "Trigger data" 

column.
 • Select "90%" in the "Trigger position" column.

(3) By clicking [ Start], 

data before trigger occurrence will be collected.

(4) Operation starts automatically if an inverter alarm
occurs.

(5) Measurement is finished when 

[ Stop] is clicked, or when the set sampling

time is elapsed.

(6) The graph display can be adjusted.

(7) Data can be saved to a file using "Save as" (Refer to page 43).

Select "RUN".

Select "Output frequency".

Select "FU".

Select the station to be measured.

Select "Alarm trigger".
Select "90".

Select "      Start".

Select "      Stop".

Changes the displayed 
position of the vertical
axis scale.

Moves up/down the
digital waveform.

Move up/down the waveform.
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3.3 Batch monitor

3.3.1 Batch monitor window
"Batch monitor" monitors more than one inverter monitored item at a time. To show the "Batch monitor" window, select [Batch 
monitor (D)] in the [Monitor] menu, or select [Batch monitor] from the project tree area.

The available "Batch monitor" functions are different when online and when offline. 

Symbol Name Function / description
A Font size Changes the size of monitor item characters.

B Row height Adjusts the row height of monitor items.

C Pause Pauses acquisition of monitor data.

D Resume Resumes acquisition of monitor data.

E Setting Sets the monitor items to display. Refer to page 70.

F No. Shows the monitor item number.

G Item Shows the monitor item.

H St. No. (Station 
number) Shows the acquired data of the corresponding station.

BA C D E

F G H
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3.3.2 Monitor setting window
The station number and monitored item to be displayed in the batch monitor window can be set by the monitor setting window. 
Selecting a monitored item will add the item in the batch monitor window, and unselecting the item will hide the item.

Symbol Name Function / description

A St. No. selection 
(Station number selection) Selects a station registered in the project.

B Monitored-item selection Sets the monitor items to display.

C Select all Selects all monitored items.

D Unselect all Unselects all monitored items.

E OK Applies all selected station numbers and monitored items to the batch monitor window.

F Cancel Discards the monitor settings, and closes the monitor setting window.

BA

D

C

FE
70 FUNCTION



Batch monitor

3

Monitored item list
 • For details on monitored items, refer to the Instruction Manual of the inverter.

Sampling item

Output frequency

Output current

Output voltage

Frequency setting value

Speed/machine speed

Motor torque

Converter output voltage

Regenerative brake duty

Electronic thermal O/L relay function load factor

Output current peak value

Converter output voltage peak value

Input power

Output power

Load meter

Motor excitation current

Position pulse

Cumulative energization time

Orientation status

Actual operation time

Motor load factor

Cumulative power

Torque command

Torque current command

Motor output

Feedback pulse

PLC function user monitor 1

PLC function user monitor 2

PLC function user monitor 3

Energy saving effect

Cumulative energy saving

PID set point

PID measured value

PID deviation

Motor thermal load factor

Inverter thermal load factor

PTC thermistor resistance

PID measured value 2

Remote output value 1

Remote output value 2

Remote output value 3

Remote output value 4

PID manipulated amount

Second PID set point

Second PID measured value

Second PID deviation

Second PID measured value 2
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NOTE
 • If a communication error occurs, batch monitoring will be stopped. To perform batch monitoring again, go offline once after 

correcting the cause of the communication error, and then go online again.
 • If an inverter fault occurs during batch monitoring, the output frequency, output current, and output voltage monitors hold the 

monitored values at the time the fault.

Second PID manipulated amount

Dancer main speed setting

Sampling item
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3.4 Diagnostics
"Diagnosis" displays fault information of the inverter.

3.4.1 Faults history function
Select [Faults history...] in the [Diagnosis] menu to display "faults history" in the sub-window.

Symbol Name Function / description

A St. No. (Station 
number) Selects a station of which fault history is to be displayed.

B Faults history clear Clears the selected station's faults history. When selected, the confirmation window appears. 
Select [Yes] to clear the faults history.

C Inverter reset Resets the selected station's inverter. When selected, the confirmation window appears.
Select [Yes] to clear the faults history.

D Current fault Shows the current fault.

E Current warning Shows the current warning.

F Faults history Shows a list of the faults history read from the inverter. The output frequency, output current, output 
voltage, energization time, and occurrence time at the fault are displayed together.

G Fault details Shows explanations of selected fault details, check points, and corrective actions.

B C

A

F

G
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3.5 Test Operation

3.5.1 Test operation window

Select [Test operation...] in the [Test operation] menu or  in the toolbar to display the test operation window.

Symbol Name Function/description

A St. No. (Station 
number) Selects a station to perform test operation with.

B Operation mode 
switch Switches over the inverter's operation mode.

C Operation mode

PU PU operation mode

EXT External operation mode

NET NET operation mode

PU + EXT External/PU combined operation mode

 Indicates that the operation mode information was not acquired properly.

No display Nothing is displayed when offline.

D Operating status

FWD Rotating forward

REV Rotating reversely

STOP Stopped

ALARM Being stopped by the fault

 Appears when operating status information acquisition fails.

No display Nothing is displayed when offline.

E Operation command

STF During forward rotation command

STR During reverse rotation command

 Indicates that the operating status information was not acquired properly.

No display Nothing is displayed when offline.

F Setting Set the running frequency.

G Run/Stop command 
buttons Sends the run/stop commands.

E
A

CB

D

F

G
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3.5.2 Displaying and switching the operation mode
The operation mode can be switched by selecting the [PU], [EXT], or [NET] operation mode switching button or by selecting 
[PU], [EXT], or [NET] in the [Operation mode (Z)] menu.
The connected inverter's operation mode can be verified in the operation mode indicator.

NOTE
 • Some operation modes cannot be switched according to the present operation mode and parameter settings. For example, 

the initial setting does not allow switching between the PU operation mode and the Network operation mode. (For details, 
refer to the Instruction Manual (Detailed) of the inverter.)

3.5.3 Specifying the running frequency (rotation speed, 
machine speed)

Input a desired frequency (rotation speed, machine speed) to the frequency (speed) input section and press the [Setting] 
button to write the set frequency to the inverter. To increase or decrease a read setting frequency in minimum setting 
increments, use the buttons at the right side of the input section. The unit indicator varies depending on the frequency setting.

Symbol Name Function/description

A Frequency

Frequency/
rotation speed/
machine speed

Appears in the following situations.
• When offline
• When the selected station's set frequency unit is other than the frequency, rotation 
speed, and machine speed.

• When the set frequency information acquisition fails.

Frequency Appears when the frequency (Hz) has been set as the set frequency unit for the 
selected station.

Rotation speed Appears when the rotation speed (r/min) has been set as the set frequency unit for 
the selected station.

Machine speed Appears when the machine speed has been set as the set frequency unit for the 
selected station.

B Setting Sets the set frequency.

Switches to the PU 
operation mode.

Switches to the External 
operation mode.

Switches to the Network operation mode.
Operation mode indication

Increase/decrease the frequency 
(rotation speed, machine speed) 

in minimum increments.

A B
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3.5.4 Running the inverter in test operation 
(forward rotation, reverse rotation, and stop 
commands)

Press the [Forward rotation] or [Reverse rotation] button to execute test operation. Press the STOP button to stop operation. 
Selecting "Operate while the Forward rotation or Reverse rotation button is pressed" will execute test operation only while the 
[Forward rotation] or [Reverse rotation] button is held down. Simply pressing the [Forward rotation] or [Reverse rotation] 
button will write the input frequency value to the inverter. After the value is written to the inverter, the test operation will start. 
Release the [Forward rotation] or [Reverse rotation] button to stop the operation.

NOTE
 • Open the batch monitor window (on page 69) to check the output frequency during test operation.
 • If FR Configurator2 had to be terminated, stop the operation by sending an operation stop command to the inverter.
 • Do not press an individual operation button, such as [Forward rotation] or [Reverse rotation], repeatedly. Doing so may make 

the FR Configurator2 operation unstable.
If operation continues unintentionally, press [Stop] to stop operation.

 • When the following action is performed due to the Windows operation method, operation may continue without the [Forward 
rotation] or [Reverse rotation] button being held down. Press the [Stop] button to stop operation.

 • Drag the mouse cursor off the button while holding down the [Stop] button.

Symbol Name Function/description
A Forward rotation Rotates the motor forward.

B Reverse rotation Rotates the motor reversely.

C Stop Stops the operation.

D Operation option Selecting this box will execute test operation only while the [Forward rotation] or [Reverse rotation] 
button is held down.

Caution
 If communication fails (due to, for example, cable disconnection), the inverter cannot be stopped 

from the personal computer.
Ensure safety by, for example, enabling signal loss detection (Pr.122, Pr.336, or Pr.548) or externally 
setting a stop device. 

A

D

B

C
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3.6 Using the PLC function
Developer is used for creating sequence programs and writing them to the inverter to enable the use of the PLC function of 
the inverter.
PLC function is used for customizing inverter operation to meet the machine specifications. PLC function operates the inverter 
according the input signals, or outputs signals and monitored values according to inverter operation.

3.6.1 Before using Developer
When using Developer, enable the PLC function of the inverter (Pr.414 PLC function operation selection  0).

Outline of PLC function
When Pr.414 = "2", the sequence start (SQ) signal from the external input terminal is valid regardless of the Pr.338 
Communication operation command source setting.
Switch the execution key (RUN/STOP) of the sequence program by turning the SQ signal ON/OFF. The sequence program 
can be executed by turning the SQ signal ON. To input the SQ signal, set "50" in any of Pr.178 to Pr.189 (input terminal 
function selection) to assign the function to a terminal.

NOTE
 • Developer cannot be used if a communication speed setting of 4800 bps or less is set for PU connector communication 

(Pr.118) or RS-485 communication (Pr.332). To use Developer, set 9600 bps or more.

3.6.2 Starting the Developer function
Select [Developer] in the [Tool] menu to start Developer.

NOTE
 • Use the help function of Developer to refer to the contents of the manuals relevant to Developer. Refer to the contents of the 

manuals from [Help] (on page 81) in the Developer menu.
 • To use the USB/RS-485 conversion cable DINV-U4, set RS-232C (initial setting) in the PC side I/F in the Developer 

Connection Destination setting window.
 • A file created by GX Developer or GX Works2 cannot be used by Developer of FR Configurator2. Conversely, a file created 

by Developer of FR Configurator2 cannot be used for GX Developer or GX Works2.

Pr. Name Initial value Description
414
A800 PLC function operation selection 0 (PLC function disabled)

1 (SQ signal external/network)
2 (SQ signal external input)
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3.6.3 Basic menu
The following table shows the basic menus of Developer. The basic menus can be operated in the same way under any 
window condition. For details on each function, refer to each Instruction Manual of GX Works2.

Menu Pull-down menu Sub-menu Sub-menu 2 Icon

Project

New... — —

Open... — —

Close — — —

Save — —

Save As… — — —

Delete... — — —

Verify — — —

Change Project Type — — —

Object

New... —

Rename — —

Delete — —

Copy —

Paste —

Set as Default Connection — —

Property... —

Print (J)… — —

Print Preview (B)… — — —

Print Window... — — —

Print Window Preview — — —

Printer Setup... — — —

Recently used GXW2 project path 
1 to 4 — — —

Exit (Q) — — —

Edit

Undo — —

Redo — —

Cut — —

Copy — —

Paste — —
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Find/Replace

Cross Reference — — —

Device List — — —

Find Device — —

Find Instruction — —

Find Contact or Coil — —

Find String — — —

Replace Device — — —

Replace Instruction — — —

Replace String — — —

Change Open/Close Contact — — —

Device Batch Replace — — —

Register to Device Batch Replace — — —

Compile
Build — —

Rebuild All — —

View

Toolbar

Standard — —

Program Common — —

Docking Window/Switch 
Project Data — —

Intelligent Function Module — —

Display All — —

Statusbar — — —

Colors and Font... — — —

Docking Window

Navigation —

Element Selection —

Output —

Cross Reference —

Device Use List —

Watch1 to 4 — —

Find/Replace —

Online

Read from PLC... — —

Write to PLC... — —

Verify with PLC... — — —

Remote Operation(S)... — — —

Password/Keyword

New... — —

Delete... — —

Disable... — —

Menu Pull-down menu Sub-menu Sub-menu 2 Icon
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Online

Monitor

Start Monitoring (All Windows) —

Stop Monitoring (All Windows) —

Start Monitoring —

Stop Monitoring —

Change Value Format(Decimal) — —

Change Value 
Format(Hexadecimal) — —

Device / Batch Monitor —

Monitor Condition Setting... — —

Monitor Stop Condition 
Setting... — —

Change Instance (Function 
Block)... — —

Watch

Start Watching — —

Stop Watching — —

Display Format of Bit Device

Number Display —

ON/OFF Display —

Symbol Display —

Register Watch — —

Debug Modify Value... — —

Diagnostics PLC Diagnostics... — — —

Tool

IC Memory Card
Read IC Memory Card... — —

Write IC Memory Card... — —

Check Program... — — —

Check Parameter... — — —

Clear All Parameters (F)... — — —

Device/Label Automatic-Assign 
Setting... — — —

Block Password... — — —

Merge Data... — — —

Language Selection... — — —

Options — — —

Window

Cascade — — —

Tile Vertically — — —

Tile Horizontally — — —

Arrange Icons — — —

Close All — — —

Other Window... — — —

Menu Pull-down menu Sub-menu Sub-menu 2 Icon
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Help

FR-A800 Programming Manual — — —

GX Works2 Help... — —

Operating Manual

GX Works2 Beginner’s Manual 
(Simple Project)(1) — —

GX Works2 Beginner’s Manual 
(Structured Project)(2) — —

Operating Manual Common(3) — —

Operating Manual (Simple 
Project)(4) — —

Operating Manual (Structured 
Project)(5) — —

Operating Manual
Intelligent Function Module (6) — —

Operating Manual
Simple Project, Function Block 
(7)

— —

Menu Pull-down menu Sub-menu Sub-menu 2 Icon
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3.6.4 Ladder edit menu
The following menus can be used for ladder editing by Developer. The following menus include SFC-Zoom. For details on 
each function, refer to each Instruction Manual of GX Works2.

Menu Pull-down menu Sub-menu 1 Sub-menu 2 Icon

Edit

Continuous Paste (Q)... — — —
Delete... — — —
Restore After Ladder Conversion — — —
Insert Row — — —
Delete Row — — —
Insert Column — — —
Delete Column — — —
NPO Batch Insert... — — —
NPO Batch Delete — — —

Edit Line — —

Delete Line — —

Change TC Setting... — — —

Ladder Edit Mode (Z)
Read Mode —

Write Mode —

Ladder Symbol

Open Contact... —

Close Contact... —

Open Branch... —

Close Branch... —

Coil... —

Application Instruction... —

Vertical Line... —

Horizontal Line... —

Delete Vertical Line... —

Delete Horizontal Line... —

Pulse Contact Symbol

Rising Pulse...

Falling Pulse...

Rising Pulse Branch...

Falling Pulse Branch...

Rising Pulse Close...

Falling Pulse Close...

Rising Pulse Close Branch...

Falling Pulse Close Branch...

Invert Operation Results... —
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Edit

Ladder Symbol

Operation Result Rising 
Pulse... —

Operation Result Falling 
Pulse... —

Inline Structured Text

Insert Inline Structured Text 
Box —

Display Template —

MarkTemplate(Left) —

MarkTemplate(Right) (J) —

Edit FB Instance... — — —

Documentation

Device Comment —

Statement —

Note —

Statement/Note Batch Edit... —

Easy Edit

Connect Line to Right-Side 
Symbol — —

Connect Line to Left-Side 
Symbol — —

Enter/Delete HLine Rightward — —
Enter/Delete HLine Leftward — —
Enter/Delete VLine Downward — —
Enter/Delete VLine Upward — —
Switch Open/Close Contact — —
Switch Statement/Note Type — —
Instruction Partial Edit — —
Edit List for Ladder Block... — —

Read from CSV File(J)... — —

Write to CSV File(K)... — —

Find/Replace

Change Module I/O No.... — — —
Switch Statement/Note Type... — — —

Line Statement List... — —

Jump... — — —
Jump to Next Ladder Block Start... — — —
Jump to Previous Ladder Block 
Start… — — —

Next Device — — —
Next Contact (Y) — — —
Next Coil (Z) — — —
Back — — —

Menu Pull-down menu Sub-menu 1 Sub-menu 2 Icon
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View

Comment — — —
Statement — — —
Note — — —
Display Lines of Monitored Current 
Value (W)... — — —

Display Format for Device 
Comment (Q)... — — —

Display Ladder Block

Hide Ladder Block — —
Display Ladder Block — —
Hide All Ladder Block — —
Display All Ladder Block — —

Device Display
Device Display —

Batch Device Display — —
Cancel All Device Display — —

Display Compile Result... — — —

Zoom... — —

Text Size
Bigger — —
Smaller — —

Open Other Windows

Open Reference Window — —
Update Reference Window — —
Open Reference Source 
Window — —

Tile FB Horizontally — —
Open Header — —

Open Instruction Help — — —

Menu Pull-down menu Sub-menu 1 Sub-menu 2 Icon
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3.6.5 Structured ladder edit menu
The following menus can be used for structured ladder edit by Developer. For details on each function, refer to each 
Instruction Manual of GX Works2.

Menu Pull-down menu Sub-menu Icon

Edit

Delete... — —

Select Mode —

Interconnect Mode —

Guided Mode

Guided Editing

Overwrite Mode —

Insert Mode —

Line Mode —

Auto Comment

Auto Connect —

Recalculate Line — —

Insert Row —

Insert Column —

New Ladder Block List

Top —

Before

After

Bottom —

Input Instruction —

Ladder Symbol

Open Contact

Close Contact

Coil

Jump

Return

Open Branch

Close Branch

Input Label

Output Label

Horizontal Line Segment

Vertical Line Segment

Rising Pulse

Falling Pulse
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Edit

Ladder Symbol

Rising Pulse Close

Falling Pulse Close

Comment

Ladder Block Label…

Left Power Rail

List Operands... —

Number of Pins
Increment

Delete...

Ladder Block List... — —

Signal Configuration
Configure... —

Toggle —

Find/Replace Jump... — —

View

View Mode

Label —

Device —

Address —

Comment —

Change Label-Device-Address Mode —

Change Label-Comment Mode —

All Device Display — —

Cancel All Device Display — —

Grid — —

Print Wrap Position — —

Display Compile Result... — —

Zoom

Set Zoom Factor... —

Increase Zoom

Decrease Zoom

Zoom Header/Body
Header —

Body —

Open Header — —

Menu Pull-down menu Sub-menu Icon
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3.6.6 Label edit menu
The following menus can be used for label (global labels, local labels, tasks, and structures) edit by Developer. For details on 
each function, refer to each Instruction Manual of GX Works2.

3.6.7 Device comment edit menu
The following menus can be used for device comment editing by Developer. For details on each function, refer to each 
Instruction Manual of GX Works2.

Menu Pull-down menu Sub-menu Icon

Edit

Delete... — —
Select All — —

New Declaration (Before) —

New Declaration (After) —

Delete Row —

Read from CSV File(J)... —

Write to CSV File(K)... —

Sort

Class —
Label Name —
Data Type —
Constant —
Device —
Comment —
Remark —

Unused label list (J) — —

Menu Pull-down menu Icon

Edit

Delete... —

Select All —

Clear All —

Clear All (All Devices) —

Read from CSV File(J)...

Write to CSV File(K)...

Hide Bit Specification Information —

Show Bit Specification Information —

Cut The Range including Hidden Bit 
Specification Information —

Copy The Range including Hidden Bit 
Specification Information —

Paste The Range including Hidden Bit 
Specification Information —
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3.6.8 Verification result menu
The following menus can be used for showing verification results by Developer. Verification is performed between the project 
of Developer and other project data, or the data (program, parameter, etc.) in the programmable controller CPU. For details on 
each function, refer to each Instruction Manual of GX Works2.

Menu Pull-down menu Icon
Edit Write to CSV File(K)... —

Find/Replace
Next Unmatch

Previous Unmatch

View

Return to Result List

Close Detail Result

Close Detail Result
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3.7 USB memory parameter copy file edit 
function

The USB memory parameter copy file editor is a dedicated software for editing setting values of USB memory parameter copy 
files of the FR Configurator2 compatible models.
To start the USB memory parameter copy file editor, choose [USB memory parameter copy file edit] in the [Tool] menu.

3.7.1 USB parameter copy file editor menu and toolbar
The following functions can be accessed from the menu.

The following functions can be accessed from the toolbar.

Menu Pull-down menu Toolbar
icon Function/description

File

Open... Shows the "Open" dialog box, and opens the USB memory parameter copy file (*.cp1).

Close... — Closes the Open file edit window.

Save Saves the USB memory parameter copy file (*.cp1).

Save As... — Shows the "Save as" dialog box. Verifies the save location, and saves with the specified 
[File Name]. The extension for savable parameter information files is *.cp1.

Exit — Exits the USB parameter file editor.

View

System — Switches between show/hide of the system toolbar.
Edit — Switches between show/hide of the edit toolbar.
Search — Switches between show/hide of the search toolbar.
Verify — Switches between show/hide of the verify toolbar.

Tool Verify Shows the Verify file selection window.

Window

Cascade — Shows the open windows in an overlapping and slightly shifted state.
Tile Vertically — Shows the open windows side-by-side.
Tile Horizontally — Shows the open windows with one on top of the other.
Arrange icons — Arranges icons which represent different windows.
Close All — Closes all open windows.

Help USB parameter copy  
file editor help Help appears.

Symbol Name Function/description
A Open Shows the "Open" dialog box, and opens the USB memory parameter copy file (*.cp1).
B Save Saves the USB memory parameter copy file (*.cp1).
C Help Help appears.
D Undo Returns the edited parameter setting value to the setting value before editing.
E Redo Redoes the setting value changed by "Undo".

F Verify Verifies the setting value in the USB memory parameter copy file (*.cp1) with the initial value or setting 
values in other USB memory parameter copy files (*.cp1).

G Search Inputs the character string, and searches for a matching character string from within the parameter list.

H Back Locations that contain the matching character string will be selected from the selected parameter list 
search column from the bottom.

I Next Locations that contain the matching character string will be selected from the selected parameter list 
search column from the top.

J Target item Specifies the column to search.

A B C D E F G H I J
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3.7.2 Editing parameter setting values
The listed setting values can be edited from the file edit window.
The file edit window can be shown by opening the USB memory parameter copy file.

NOTE
 • Edited setting values are not checked when saving the USB memory parameter copy file or when writing to the inverter. 

Therefore, even values that cannot normally be set to the inverter (setting range, write-limited values) are written to the 
inverter. In this case, because operation of the inverter cannot be guaranteed, change setting values with extreme caution.

 • To display the explanation about a parameter on the help window, double-click the parameter in the parameter list.
 • Changing a parameter by FR Configurator2 may affect other parameter settings.
 • When using the FR-A820-55K (03160) or FR-A840-55K (01800), do not change Pr.570 Multiple rating setting from SLD or 

LD rating (Pr.570 = "0 or 1") to ND or HD rating, or vice versa.
 • Do not change the Pr.71 Applied motor and Pr.450 Second applied motor settings from an induction motor to a PM motor 

or vice versa.
 • Calibration parameters cannot be set.

Symbol Name Function/description
A Title bar Shows the file name of the open file.

B Model Shows the model set by the file.

C Parameter list Shows the parameters of the USB memory parameter copy file.

D No. Shows the parameter number.

E Name Shows the parameter name.

F Setting range Shows the setting range of the parameter setting value.

G Min. unit Shows the minimum setting unit of the parameter setting value.

H Initial value Shows the factory default parameter setting values of the inverter.

I Setting value Shows the parameter setting values saved to the USB memory parameter copy file, and inputs the 
setting values to be written to the inverter. Setting values cannot be set as blank.

A

B

C

D E F G H I
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3.7.3 Verifying parameters
A list of differences between the USB memory parameter copy file to verify (*.cp1) and the parameter initial values or the 
parameter setting values of the verify destination file (*.cp1) can be displayed.

The "Verify file selection" window can be displayed by selecting [Verify] in the [Tool] menu, or by selecting  from the toolbar.

Verify result window

NOTE
 • Parameter setting values cannot be input to the verify source and verify destination cells.

Symbol Name Function/description

A Source

Specifies the verify source file.
The method for specifying the file is as follows.
• Input the path of the file to verify (*.cp1) in the verify source text box.
• Select  in the verify source text box, and specify the file by opening the "Open file" dialog.
• With the file edit window open, open the "Verify file selection" window, and the path of the selected 
edit window file (*.cp1) will appear in the text box.

B Destination

When the option button for "Initial value" is selected, parameter verification will be performed against 
the initial parameter settings of the verify source inverter model. When the option button for "File" is 
selected, parameter verification is performed against the parameter settings of the inverter model 
specified by a file (*.cp1). Set a file.

C OK Verification of the verify source parameter values with the verify destination parameter values starts.
D Cancel Closes the verify file selection window without performing verification.

Symbol Name Function/description

E Title bar Shows the verify source file name and the verify destination file name.
If the initial value is specified as the verify destination, "[Initial value]" is displayed.

F Source Shows the parameter setting value of the file (*.cp1) specified by verify source in the "Verify file 
selection" window.

G Destination

If the verify destination is the initial value
Shows the initial value as the verify destination.
If the verify destination is a file
Shows the parameter setting value of the file (*.cp1) specified by verify destination in the "Verify file 
selection" window.

A

B

C D
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3.8 Help

3.8.1 Help window
The Help window shows the contents of the software and inverter's instruction manuals.
There are the following ways of displaying Help.

 • Select [FR Configurator2 Help...F1] in [Help] menu.

 • Click  on the toolbar.
 • Press the F1 key.
 • Double clicking a parameter on the parameter list will show the explanation of the selected parameter.

Symbol Name Function/description

A Hide

Hides the navigation panel, [Contents], [Index], and [Search] tabs.  While hiding the navigation panel 

and the tabs, the button changes to . Click  to display the navigation panel and the tabs 

again.

B Back Returns to the previous help description.

C Forward Click this to read forward the help description again after using .

D Print Prints help description.

E Minimize button Minimizes the help window.

F Maximize button Maximizes the help window.

G Close button Exits the help window.

H Contents Click this to check the contents. Contents will be displayed in the navigation panel.

I Index Click this to use the index. Index will be displayed in the navigation panel.

J Search Click this to use the search function. Search will be displayed in the navigation panel.

K Navigation Display the Contents, Index, or Search.

L Contents Shows help description.

K

B C D E F GA
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 • HTML format and link
Help description is displayed in the contents panel. Help description is displayed in HTML format. Hyperlink is available to 
jump to the related help description. Hyperlink in description is shown in blue and underline.

 • Contents
Click [Contents] to display a list of contents. Click a desired item to show the help description.

 • Index
Click [Index] to display the index of keywords contained in the Help.
Type characters to narrow down the index search. Click a desired item to show the help description. 

 • Search
Click [Search] to display the search panel. Type a character string and click [List Topics] to perform full-text search with the 
character string in the Help. Click a desired topic in the search result to show the help description.

Click an item.

Click to open the Contents.

Type characters to narrow down the index search.

Click to open the Index.

Double click to display the related description.

Type a character string to search.

Click to display the Search.

Double click to display the search result.

Click to search the input character string.
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3.8.2 Version information
Go to [Help] and select [Version...] to show the software version of the FR Configurator2.

Symbol Name Function/description
A Version information Shows the version information of the FR Configurator2.

B Registration Shows the information registered during installation.

C OK
Exits the version information window.

D Close button

C

B

A

D
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INDICATION

This chapter explains the "trouble indications" of this product.
Always read the instructions before using the equipment.
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Error code
4.1 Error code
If an error occurs, the following error codes and error messages appear in the error detail display area.

4.1.1 Communication error with the inverter
NOTE

 • If a timeout error occurs, set the FR Configurator2 to the offline mode. Check the connection of the communication cable, 
etc., and remove any error causing condition, then set it to online.

 • The parameter list of FR Configurator2 shows the parameters of the latest inverter at the time of the FR Configurator2 
upgrade. (For the upgrade timing of FR Configurator2, refer to page 102.) The parameters' setting range, initial value, and 
numbers may be different before and after a version upgrade (with functions added).

Error code 
(HEX) Error message Possible cause Countermeasure

0x80A00101 The communication line 
cannot be opened.

• Communication setting is not set for the 
USB while connecting via USB.

• No communication port exists on the 
personal computer, or it is not 
recognized.

• Check the connection type on the [System 
setting] window. 
(Refer to page 35)

• Check that a communication ports exists on 
the personal computer.

0x80A00104
0x80A00107
0x80A0010A

An unexpected error 
occurred in S/W. Please contact your sales representative.

0x80010000

The transmission data from 
the computer was 
containing errors for the 
permissible number of 
retries or more.

• The Pr.124 PU communication CR/LF 
selection and Pr.341 RS-485 
communication CR/LF selection 
settings are different with the software 
settings.

• Electromagnetic interference.
• Cable breakage.

• Match the Pr.124 PU communication CR/
LF selection and Pr.341 RS-485 
communication CR/LF selection settings 
with the software settings.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Replace the cable.

0x80010001 The content does not match 
with the specified parity.

• The Pr.120 PU communication parity 
check and Pr.334 RS-485 
communication parity check selection 
settings are different with the software 
settings.

• Electromagnetic interference.
• Cable breakage.

• The Pr.120 PU communication parity 
check and Pr.334 RS-485 communication 
parity check selection settings are 
different with the software settings.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Replace the cable.

0x80010002

The sum check code of the 
computer is different from 
the sum check code of the 
data received by the 
inverter.

• The communication setting is different 
between the inverter and the software.

• Data is corrupted due to electromagnetic 
noise, etc.

• Make the same communication setting.
• Check for electromagnetic noise and 
wiring.

0x80010003

The data received by the 
inverter contains a syntax 
error. Or the inverter was 
not able to receive the data 
within the specified time.

• The Pr.124 PU communication CR/LF 
selection and Pr.341 RS-485 
communication CR/LF selection 
settings are different with the software 
settings.

• Electromagnetic interference.
• Cable breakage.

• Match the Pr.124 PU communication CR/
LF selection and Pr.341 RS-485 
communication CR/LF selection settings 
with the software settings.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Replace the cable.

0x80010004
The stop bit length is 
different from the initial 
value.

• The Pr.119 PU communication stop bit 
length / data length and Pr.333 RS-485 
communication stop bit length / data 
length settings are different with the 
software settings.

• Electromagnetic interference.
• Cable breakage.

• Match the Pr.119 PU communication stop 
bit length / data length and Pr.333 RS-
485 communication stop bit length / data 
length settings with the software settings.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Replace the cable.
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0x80010005
Because of incorrect wiring, 
data was transmitted before 
completing a data reception.

• The settings of Pr.123 PU 
communication waiting time setting 
and Pr.337 RS-485 communication 
waiting time setting are too small.

• Electromagnetic interference.
• Cable breakage.

• Set a larger value in Pr.123 PU 
communication waiting time setting and 
Pr.337 RS-485 communication waiting 
time setting.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Replace the cable.

0x80010007

The inverter received an 
unusable character (other 
than 0 to 9, A to F, or control 
codes).

• The Pr.119 PU communication stop bit 
length / data length and Pr.333 RS-485 
communication stop bit length / data 
length settings are different with the 
software settings.

• Electromagnetic interference.
• Cable breakage.

• Match the Pr.119 PU communication stop 
bit length / data length and Pr.333 RS-
485 communication stop bit length / data 
length settings with the software settings.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Replace the cable.

0x8001000A A mode error occurred.

A test operation was attempted without 
setting FR Configurator2 as the operation 
(start) command source, for example in 
the External operation mode (EXT).

Change the operation mode to the PU 
operation mode (or NET).
Check the setting values of Pr.338 
Communication operation command 
source, Pr.550 NET mode operation 
command source selection, and Pr.551 
PU mode operation command source 
selection.
(The operation command source changes 
according to inverter communication 
connection. Refer to page 14, 28.)

0x8001000C
Any value outside the 
setting range cannot be 
written.

An out-of-range value or operation 
frequency was written to the parameter.

Set a value within the setting range, and 
enter the setting.
If a writing error occurs even if a value within 
the setting range is written, check for the 
writing requirements. For the details on the 
writing requirements, refer to the Instruction 
Manual of the inverter.

0x80010011
The parameter outside the 
setting range cannot be 
written.

An out-of-range value was written to the 
parameter.

Set a value within the setting range, and 
enter the setting.
If a writing error occurs even if a value within 
the setting range is written, check for the 
writing requirements for each parameter. For 
the details on the writing requirements, refer 
to the Instruction Manual of the inverter.

0x80010012 A mode error occurred.

• Pr.79 Operation mode selection is not 
set for PU/NET (RS-485).

• A parameter or frequency setting was 
attempted without setting FR 
Configurator2 as such command source, 
for example in the External operation 
mode (EXT).

• Click [PU] button of Test operation. Change 
the setting of Pr.79 for PU/NET (RS-485).

• Change the operation mode to the PU 
operation mode (or NET).
Check the setting values of Pr.339 
Communication speed command 
source, Pr.550 NET mode operation 
command source selection, and Pr.551 
PU mode operation command source 
selection.
(The operation command source changes 
according to inverter communication 
connection. Refer to page 14, 28.)

0x80010013 No parameter can be written 
during inverter running.

Parameter writing was attempted during 
inverter operation.

Perform parameter writing after the inverter 
is stopped.

0x80010014
The setting value cannot be 
written to the parameters to 
which writing is prohibited.

• Writing is disabled by Pr.77 Parameter 
write selection.
Set Pr.77 = "1 (write disabled)".

• Password lock is activated.

• Set Pr.77 Parameter write selection to 
other than "1".

• Enter the password in Pr.297 to unlock the 
password lock.

0x80010016 Non-existed parameters 
cannot be read or written.

• The version of the parameter file in the 
setup software is different from the 
inverter version.

• Simple mode is set by Pr.160 User 
group read selection.

• Password lock is activated.

• Reinstall the software.
• Change the setting of Pr.160 to choose a 
mode other than the simple mode.

• Enter the password in Pr.297 to unlock the 
password lock.

Error code 
(HEX) Error message Possible cause Countermeasure
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0x80010017 The set option is not 
connected to the inverter.

Reading of option parameter was 
attempted while the option is not installed. Install the option to the inverter.

0x80010018
The bias and gain settings 
for an analog value are too 
close.

There is only small difference between the 
gain and bias settings for an analog value.

Widen the gap between the gain and bias 
settings for an analog value.

0x8001001A An unsupported model is 
connected. Please contact your sales representative.

0x80010021
The mode cannot be 
switched during inverter 
running.

Change the operation mode after the 
inverter stops.

Set Pr.77 Parameter write selection to "2".
Stop the inverter.

0x80010022

While the forward rotation 
command (STF) is ON, the 
operation mode cannot be 
switched to the External 
operation mode.

Switching to the External mode was 
attempted while the forward rotation signal 
(STF) is ON.

Change the operation mode after switching 
STF to OFF.

0x80010023

While the reverse rotation 
command (STR) is ON, the 
operation mode cannot be 
switched to the External 
operation mode.

Switching to the External mode was 
attempted while the reverse rotation signal 
(STR) is ON.

Change the operation mode after switching 
STR to OFF.

0x80010024
The mode cannot be 
switched during the present 
operation mode.

The operation mode was attempted to be 
switched to the mode other than the one 
selected by Pr.79 Operation mode 
selection.

Change the setting of Pr.79 Operation 
mode selection.

0x80010025 The inverter cannot be reset 
with the present setting.

Reset is disabled by Pr.75 Reset 
selection/disconnected PU detection/
PU stop selection.

Change the setting of Pr.75 Reset 
selection/disconnected PU detection/PU 
stop selection.

0x80010026 An unexpected error 
occurred in S/W. Please contact your sales representative.

0x80010101
Communication was not 
established with the inverter 
within the timeout time.

• The settings of Pr.122 PU 
communication check time interval, 
Pr.336 RS-485 communication check 
time interval, and Pr.548 USB 
communication check time interval are 
too small.

• Electromagnetic interference.
• Cable breakage/damage.
• Personal computer port is set disabled or 
its port is broken.

• Set a larger value in Pr.122 PU 
communication check time interval, 
Pr.336 RS-485 communication check 
time interval, and Pr.548 USB 
communication check time interval.

• Set a larger value for the timeout setting of 
the software.

• Connect or replace the cable.
• Activate the port using Device Manager, or 
replace the port.

0x80010102
The data received by the 
computer contains incorrect 
data.

• The Pr.124 PU communication CR/LF 
selection and Pr.341 RS-485 
communication CR/LF selection 
settings are different with the software 
settings.

• Electromagnetic interference.
• Inverter reset (or power-OFF)
• Cable breakage.

• Match the Pr.124 PU communication CR/
LF selection and Pr.341 RS-485 
communication CR/LF selection settings 
with the software settings.

• Set a larger value in Pr.121 Number of PU 
communication retries and Pr.335 RS-
485 communication retry count.

• Do not reset the inverter or turn OFF the 
inverter power during communication.

• Replace the cable.

0x80020001 An unexpected error 
occurred in S/W. Please contact your sales representative.

0x80020002
The parameter outside the 
setting range cannot be 
written.

An out-of-range value was written to the 
parameter.

Set a value within the setting range, and 
enter the setting.
If a writing error occurs even if a value within 
the setting range is written, check for the 
writing requirements for each parameter. For 
the details on the writing requirements, refer 
to the Instruction Manual of the inverter.

0x80020003
0x80020004

An unexpected error 
occurred in S/W. Please contact your sales representative.

Error code 
(HEX) Error message Possible cause Countermeasure
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0x80020005
0x80020006
0x80020007
0x80020008

The reception data could 
not be acquired.

The sampling data could not be obtained 
by the high speed sampling.

Close other applications.
Set a larger value for the mask count.
Decrease the number of sampling channels.

0x80020009
The time cannot be set if the 
difference with the inverter 
time is 10 years or more.

Real time clock setting error Set appropriate time in Pr.1006 to Pr.1008 of 
the inverter.

0x80030001
The specification of the 
communication port is 
incorrect.

The communication port is set disabled.
Another application is already using the 
port.

Activate the port using Device Manager.
Close other applications, and go online.

0x80030002
0x80030003
0x80030004
0x80030005
0x80030006
0x80030007
0x80030008
0x80030009
0x8003000A
0x8003000B

An unexpected error 
occurred in S/W.

Please contact your sales representative.

0x8003000C
Duplication was detected in 
station number of the USB 
communication.

0x8003000D An unexpected error 
occurred in S/W. Please contact your sales representative.

0x8003000E The driver is not installed  or 
broken. The driver is not installed or is broken. Reinstall the software.

0x8003000F
0x80030010
0x80030011
0x80030012
0x80030013

An unexpected error 
occurred in S/W. Please contact your sales representative.

Error code 
(HEX) Error message Possible cause Countermeasure
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Error code
4.1.2 Communication error when connected through 
GOT

NOTE
 • If a Time Out error occurs, set FR Configurator2 to OFFLINE. Please check a communication cable connection etc, to fix the 

error and then set FR Configurator2 to ONLINE again.
 • The parameter list of FR Configurator2 shows the parameters of the latest inverter at the time of the FR Configurator2 

upgrade. (For the upgrade timing of FR Configurator2, refer to page 102.) The parameters' setting range, initial value, and 
numbers may be different before and after a version upgrade (with functions added).

Error Code 
HEX) Error Message Cause Countermeasure 

0x80110001 An unexpected error 
occurred to S/W. GOT type error. Check for the GOT type.

0x80110002
0x80110003

An unexpected error 
occurred to S/W. Please contact your sales representative.

0x80110004

Failed to make a  
communication with the 
inverter during the time set 
with Time Out.

Communication protocol of the inverter and 
GOT are not the same.
Setting of Pr. 122 PU communication 
check time interval, Pr. 336  RS-485 
communication check time interval, Pr. 
548  USB communication check time 
interval  is other than "0".
Electromagnetic interference
Cable breakage/damaged

Set communication protocol of the inverter 
and GOT same.
Set a value other than "0" in Pr. 122 PU 
communication check time interval, Pr. 
336  RS-485 communication check time 
interval, Pr. 548  USB communication 
check time interval .
Set larger value for Time Out setting of the 
software.
Cable connection/replacement 
Check for communication cable and power 
supply of devices.

0x80110005

Failed to make a  
communication with the 
inverter during the time set 
with Time Out.

FR Configurator2 was started and a 
communication was established when GX 
drawing software was starting.

After closing GX drawing software, try 
communication again.

0x80110006

Failed to make a  
communication with the 
inverter during the time set 
with Time Out.

GX drawing software was started when FR 
Configurator2 was starting.

After closing GX drawing software, try 
communication again.

0x80110007 An unexpected error 
occurred to S/W. Communication line quality error Set lower baud rate and make a 

communication.

0x80110008 An unexpected error 
occurred to S/W.

Baud rate not supported by connected 
device

Check for the baud rate supported by 
connected devices.

0x80110009

Failed to make a 
communication with the 
inverter during the time set 
with Time Out.

Electromagnetic interference
Cable breakage/damage

Set larger value for Time Out setting of the 
software.
Cable connection/replacement  
Check that line is connected.

0x8011000A

Failed to make a  
communication with the 
inverter during the time set 
with Time Out.

Other process is ongoing in GOT and line is 
BUSY.
(retry is performed in the EZSocket)
A station not connected is being monitored.

Set a larger value for Time Out setting of 
the software.
Monitor only the station which the GOT is 
connected.
Check that the GOT is operating correctly 
and try again.

0x8011000B An unexpected error 
occurred to S/W. Protocol type error Check for protocol type.

0x8011000C An unexpected error 
occurred to S/W. Host name error Check for connected GOT host name.

0x8011000D An unexpected error 
occurred to S/W. Socket port number error Check for the port number.
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0x80111001
0x80111002
0x80111003
0x80111004
0x80111005
0x80111101
0x80111102
0x80111103
0x80111104
0x80111105
0x80111106
0x80111107
0x801111FF

Failed to make  
communication with the 
inverter during the time set 
with Time Out.

Electromagnetic interference, etc. are 
propagated when receiving GOT software.

Set a larger value for Time Out setting of 
the software and try again.

0x80112001 Wrong communication port 
is assigned. Serial line open error Check for the communication port setting.

0x80112002 An unexpected error 
occurred to S/W. Serial line closed error Try again.

0x80112003 An unexpected error 
occurred to S/W. Serial line setting error Try again.

0x80112004 An unexpected error 
occurred to S/W. Serial line baud rate error Try again.

0x80112005

Failed to make  
communication with the 
inverter during the time set 
with Time Out.

Occurred before starting FR Configurator2, 
or during communication
serial cable between the GOT and PC is 
disconnected

Connect the cable.

0x80112201 An unexpected error 
occurred to S/W.

EZSocket GOT is installed, but the file is 
broken. Install software again.

0x80112202

Failed to make  
communication with the 
inverter during the time set 
with Time Out.

Before starting FR Configurator2
A cable between the GOT and PC is 
disconnected.
The GOT power is OFF.

Connect the cable.
Power ON the GOT.

0x80112203

Failed to make  
communication with the 
inverter during the time set 
with Time Out.

Electromagnetic interference, etc. are 
affecting between the PC and GOT.

Set a larger value for Time Out setting of 
the software and try again.

0x80112204 An unexpected error 
occurred to S/W.

USB line error (at the GOT device error 
communication ending) Try again.

0x80112205 An unexpected error 
occurred to S/W. USB line error (sending function is invalid) Try again.

0x80112206 An unexpected error 
occurred to S/W. USB line error (receiving function is invalid) Try again.

0x80112207 An unexpected error 
occurred to S/W.

USB line error (cable disconnection 
registration failure) After reconnecting with the GOT, try again.

0x80112208

Failed to make  
communication with the 
inverter during the time set 
with Time Out.

USB line error (cable was disconnected 
halfway)
When a cable between the GOT and PC 
was disconnected during communication.
When the GOT power turned OFF during 
communication

Check for cable connection.
Power ON the GOT.

0x80112401 An unexpected error 
occurred to S/W. The GOT was not found on the network. Check that the GOT is connected to the 

network.

0x80112402 An unexpected error 
occurred to S/W.

Socket line open error (socket generation 
failed)

Check that specified port number is correct  
and specified IP address is for GOT.

0x80112403 An unexpected error 
occurred to S/W. Please contact your sales representative.

0x80112405 An unexpected error 
occurred to S/W. Network error Check that the GOT is connected to the 

network.

0x80112406 An unexpected error 
occurred to S/W. Connected socket forced disconnection Check that the GOT is not making a  

communication in other connection method.

Error Code 
HEX) Error Message Cause Countermeasure 
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REVISIONS
*The manual number is given on the bottom left of the back cover.

Print date *Manual number Revision

Jul. 2013 IB(NA)-0600516ENG-A First edition
(Ver.1.00 supported)

Jun. 2014 IB(NA)-0600516ENG-B Compatibility with FR-A802
(Ver.1.03D supported)
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